
S310 Series 用户手册

2011 年 10 月 www.lexmark.com

机器类型：

4448

型号：

S310 Series: 301, 30E

http://www.lexmark.com


目录

安全信息.................................................................................................5

关于您的打印机......................................................................................6
感谢您选择此打印机！...............................................................................................................6

最小化打印机对环境的影响........................................................................................................6

查找有关打印机的信息...............................................................................................................7

了解打印机的部件.......................................................................................................................9

订购和更换耗材....................................................................................11
订购打印墨盒............................................................................................................................11

使用原装 Lexmark 打印墨盒.....................................................................................................12

更换打印墨盒............................................................................................................................12

订购纸张和其他耗材.................................................................................................................13

回收 Lexmark 产品...................................................................................................................14

使用打印机操作面板按钮和菜单...........................................................15
使用打印机控制面板.................................................................................................................15

更改睡眠时限............................................................................................................................16

节约纸张和能源........................................................................................................................16

恢复出厂默认设置.....................................................................................................................16

使用打印机软件....................................................................................18
最低系统需求............................................................................................................................18

使用 Windows 打印机软件........................................................................................................18

使用 Macintosh 打印机软件......................................................................................................19

查找并安装可选软件.................................................................................................................21

更新打印机软件........................................................................................................................21

下载 PCL 和 PS 驱动程序（仅限于 Windows）.......................................................................21

重新安装打印机软件.................................................................................................................22

装入纸张和文档原件.............................................................................24
加载纸张...................................................................................................................................24

保存纸张设置............................................................................................................................27

将文档原件放置在扫描仪玻璃上...............................................................................................27

目录 2



打印......................................................................................................28
打印提示...................................................................................................................................28

打印基本文档............................................................................................................................28

在特殊介质上打印.....................................................................................................................31

打印照片...................................................................................................................................33

在纸张的双面进行打印（双面打印）........................................................................................35

管理打印作业............................................................................................................................37

从移动设备打印........................................................................................................................41

复印......................................................................................................42
复印提示...................................................................................................................................42

进行复印...................................................................................................................................42

复印 ID 卡.................................................................................................................................43

放大或缩小图像........................................................................................................................43

调整复印质量............................................................................................................................43

使复印效果变浅或者加深..........................................................................................................44

使用打印机操作面板进行逐份复印...........................................................................................44

在复印件间插入分隔页.............................................................................................................44

将多页文档复印到一张纸上......................................................................................................45

在每一页上添加背景图案信息...................................................................................................45

去除复印件背景........................................................................................................................45

进行双面复印............................................................................................................................46

取消复印作业............................................................................................................................47

扫描......................................................................................................48
扫描提示...................................................................................................................................48

扫描至本地计算机.....................................................................................................................48

扫描至网络计算机.....................................................................................................................49

扫描至闪存驱动器或存储卡......................................................................................................49

扫描照片并进行编辑.................................................................................................................49

扫描文档并进行编辑.................................................................................................................50

使用打印机软件直接扫描到电子邮件........................................................................................51

扫描为 PDF...............................................................................................................................52

扫描常见问答............................................................................................................................53

取消扫描作业............................................................................................................................53

目录 3



电子邮件...............................................................................................54
设置打印机的电子邮件功能......................................................................................................54

发送电子邮件............................................................................................................................55

取消电子邮件............................................................................................................................56

网络......................................................................................................57
在无线网络中安装打印机..........................................................................................................57

高级无线设置............................................................................................................................63

网络常见问答............................................................................................................................73

维护打印机............................................................................................86
维护打印墨盒............................................................................................................................86

清洗打印机的外壳.....................................................................................................................87

清洁扫描仪玻璃........................................................................................................................88

将打印机移到其他位置.............................................................................................................88

问题解答...............................................................................................90
在您解决问题之前.....................................................................................................................90

如果问题解答没有解决您的问题...............................................................................................90

安装问题解答............................................................................................................................90

了解打印机信息........................................................................................................................94

卡纸和进纸错误问题解答........................................................................................................102

打印问题解答..........................................................................................................................107

复印和扫描问题解答...............................................................................................................109

网络问题解答..........................................................................................................................111

注意事项.............................................................................................121
产品信息.................................................................................................................................121

版本注意事项..........................................................................................................................121

功耗........................................................................................................................................124

索引....................................................................................................126

目录 4



安全信息
将电源线连接到正确接地的电源插座上，所连接的电源插座与产品的距离不可太远，并且要符合使用方便的原
则。

请不要在水边或潮湿的地方放置或使用此产品。

当心—可能的伤害： 本产品中的锂电池不可更换。如果不正确更换锂电池，可能会有爆炸危险。不要再
充电、拆解或焚烧锂电池。丢弃旧的锂电池时应按照制造商的指导及当地法规进行处理。

请只使用随此产品提供的电源和电源线或厂商的认可替代品。

当心—电击危险：请确认所有的外部连接（例如以太网和电话系统连接）都正确地安装在各自标示的插
口中。

本产品使用特定制造商的元件，并按照严格的世界安全标准来设计、测试及验证。有些零件的安全功能特征可
能不一定很明显。对于更换其他厂家零件所造成的不良后果，制造商概不负责。

当心—可能的伤害：请不要切割、扭曲、捆绑、挤压电源线，或者在电源线上放置重物。请不要使电源
线磨损或受压。请不要将电源线塞在物体之间，例如家具和墙壁之间。如果发生了这些事情，可能会产
生火灾或电击危险。请定期检查电源线，及时发现这种问题的迹象。在检查电源线之前，请先从电源插
座上断开。

有关操作说明书中未提及的其他服务或维修，请向专业的服务人员咨询。

当心—电击危险：当清洁打印机的外部时，为避免受电击的危险，请在操作之前先从墙壁插座中拔掉电
源线并从打印机上断开所有电缆。

当心—电击危险：在雷雨天气时，请不要使用传真功能。也不要在雷雨天气时设置本产品，或者使用传
真功能、电源线或电话线进行带电操作或线缆连接。

请保留这些安全指导。
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关于您的打印机

感谢您选择此打印机！
我们经过努力的工作，确保此打印机可以满足您的需求。

如要立刻开始使用您的新打印机，请使用随同打印机一起提供的安装资料，然后快速浏览用户手册了解如何完
成基本任务。如要实现您的打印机的最佳性能，请仔细阅读用户手册，并确认您在我们的网站上检查了最新的
升级。

我们致力于通过我们的打印机提供性能和价值，并且我们希望确保您满意。如果您在使用过程中遇到任何问
题，我们知识渊博的技术支持代表将会很高兴地帮助您迅速恢复正常使用。如果您发现哪些事情我们可以做得
更好，请告诉我们。毕竟我们所做的这一切都是为了您，您的建议可以帮助我们做得更好。

最小化打印机对环境的影响
我们致力于保护环境，并且不断地改善我们的打印机以减少其对环境的影响。通过选择某些打印机设置或任
务，您可以更进一步地降低打印机对环境的影响。

节约能源
• 启用经济模式。 此功能将屏幕亮度设置为低，并设置打印机在空闲 10 分钟之后进入节约能源模式。

• 选择最低睡眠时限。 打印机空闲一段时间之后，“睡眠”功能将会让打印机进入最低能耗待机模式，这段
时间称为睡眠时限。

• 共享您的打印机。 无线／网络打印机允许您在多台计算机之间共享一台打印机，这样可以节约能源和其他
资源。

节约纸张
• 在纸张的一面上打印多页图像。 “合并打印”功能允许您在一张纸上打印多页。您最多可以在一张纸的一
面上打印 16 页图像。

• 在纸张的双面进行打印。 双面打印允许您手动或自动在纸张的双面进行打印（取决于您的打印机型号）。

• 在打印之前预览打印作业。 您可以在工具栏中、“打印”或“打印预览”对话框中或打印机的显示屏上使
用预览功能（取决于您的打印机型号）。

• 使用可回收的纸张。

• 缩小要打印的文档的边距。

• 扫描并保存。 为了避免打印多份，您可以扫描文档或照片，然后将它们保存在计算机应用程序或闪存驱动
器中进行演示。

节约墨水
• 使用“快速打印”或“草稿”模式。 使用这些模式打印文档可以比正常情况使用较少的墨水，最适合于打
印文本为主的文档。

• 使用需要较少墨水的字体类型和字体设置。 大部分程序或应用程序可让您调节颜色深浅。

• 使用高容量打印墨盒。 高容量打印墨盒中的墨水允许您打印更多的页数。
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循环利用
• 通过 Lexmark 打印墨盒回收计划返还打印墨盒以进行再利用或再循环。 如要返还打印墨盒，请访问

www.lexmark.com/recycle。 按照指导索取已付邮资的返还袋。

• 回收产品包装。

• 回收您的旧打印机，不要将其丢弃。

• 从作废的打印作业中回收纸张。

• 使用可回收的纸张。

如要浏览 Lexmark 环保报告，请访问网站 www.lexmark.com/environment。

注意：您的打印机可能不提供某些程序，或者不支持程序的某些功能（具体取决于您购买的打印机的功
能）。

查找有关打印机的信息

出版物

查找内容 所在位置

初始设置指导：

• 连接打印机

• 安装打印机软件

设置文档

设置文档随打印机附带，也可以在 Lexmark 网站上获取，网址为：
http://support.lexmark.com。

有关使用打印机的更多设置和指
导：

• 选择和保存纸张及特殊介质

• 装入纸张

• 完成打印、复印、扫描和传
真任务，取决于您的打印机
型号

• 配置打印机设置

• 查看和打印文档及照片

• 安装和使用打印机软件

• 根据打印机型号设置并配置
网络上的打印机

• 管理和维护打印机

• 检查和解决问题

用户手册

安装软件光盘中包含用户手册。

有关更新，请查看我们的网站：http://support.lexmark.com。

根据您的打印机型号创建和定制
打印机解决方案

SmartSolutions 用户手册 和帮助

请访问 http://smartsolutions.lexmark.com。单击帮助查看基本的 SmartSolutions 信
息。

关于您的打印机 7
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查找内容 所在位置

使用打印机软件的帮助 Windows 或 Mac 帮助

打开打印机软件程序或应用程序，然后单击帮助。

单击 ? 可以浏览上下文相关信息。

注意：

• “帮助”随打印机软件一起自动安装。

• 打印机软件位于打印机程序文件夹中或者计算机桌面上，具体取决于您的操作系
统。

最新的补充信息、更新和在线技
术支持：

• 问题解答提示

• 常见问答

• 文档

• 驱动程序下载

• 在线聊天支持

• 电子邮件支持

Lexmark 支持网站— http://support.lexmark.com

注意：选择您所在的国家或地区，然后选择您的产品以浏览相应的技术支持网站。

请记录以下信息（位于购买发票上和打印机内的标签上），当您联系技术支持时请准备
好这些信息，以便我们能够更快地为您服务：

• MAC 地址号码

• 序列号

• 购买日期

• 购买商店

注意：抬起扫描仪顶盖查看客户支持标签。

电话支持 在美国，请拨打我们的电话：

1‑800‑332‑4120
周一–周五（8:00 AM–11:00 PM 东部时间），周六和周日（11:00 AM–8:00 PM
东部时间）

您所在国家或地区的技术支持电话号码和服务时间可以在技术支持网站上获得
(http://support.lexmark.com)，或参阅打印机随附的保证手册。

质保信息 • 美国—请参阅打印机随附的有限质保声明，或者访问我们的网站：
http://support.lexmark.com。

• 其他国家或地区—请参阅打印机随附的质量保证手册。

注意：您的打印机可能不提供某些程序，或者不支持程序的某些功能（具体取决于您购买的打印机的功
能）。

关于您的打印机 8
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了解打印机的部件

7

5
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1

2

8

9

3

选项 用途

1 纸张支架 装入纸张。

2 进纸导轨调节杆 调整纸张导轨。

3 PictBridge 和 USB 端口 将 PictBridge 兼容数码相机或闪存驱动器连接到打印机。

4 出纸托盘 盛放打印机送出的纸张。

5 托盘扩展板 固定出来的纸张。

6 打印机控制面板 操作打印机。

7 扫描仪顶盖 打开顶盖可以露出扫描仪玻璃。

8 进纸保护盖 防止物体掉进纸张通道内。

关于您的打印机 9



选项 用途

9 进纸导轨 确保纸张能够垂直进入打印机内。

10

12

13

17

16

14

15

11

选项 用途

10 扫描仪玻璃 扫描或复印照片和文档。

11 电源插口 将打印机连接到电源线。

12 双面打印部件 • 在纸张的双面进行打印。

• 清除卡纸。

13 USB 端口 使用 USB 电缆将打印机连接到计算机。

警告—可能的损坏：除了插入或断开 USB 电缆或安装电缆的时候，请不要触摸 USB 端
口。

14 打印头保护门区域 安装打印头。

注意：当打印机内没有安装打印头时，拖车将会移动到打印头保护门区域。

15 卡纸清除盖板 找到并清除卡纸

16 打印墨盒保护门区域 安装、更换或取出打印墨盒。

17 扫描仪部件 • 抬起扫描仪部件可以露出打印墨盒和打印头。

• 清除卡纸。
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订购和更换耗材

订购打印墨盒
Lexmark S310 Series 型号（除 Lexmark S319 以外）

项目 返还计划打印墨盒 1 常规碳粉盒 2

黑色打印墨盒 150 不可用

高容量黑色打印墨盒 150XL 150XLA

黄色打印墨盒 150 不可用

高容量黄色打印墨盒 150XL 150XLA

青色打印墨盒 150 不可用

高容量青色打印墨盒 150XL 150XLA

洋红色打印墨盒 150 不可用

高容量洋红色打印墨盒 150XL 150XLA

1 只允许单次使用。使用后请将此打印墨盒返还给 Lexmark 进行再制造、再填充或再循环。

2 只在 Lexmark 网站上提供：www.lexmark.com。

Lexmark S319 型号

项目 返还计划打印墨盒 1 常规碳粉盒 2

黑色打印墨盒 160 不可用

高容量黑色打印墨盒 160XL 160XLA

黄色打印墨盒 160 不可用

高容量黄色打印墨盒 160XL 160XLA

青色打印墨盒 160 不可用

高容量青色打印墨盒 160XL 160XLA

洋红色打印墨盒 160 不可用

高容量洋红色打印墨盒 160XL 160XLA

1 只允许单次使用。使用后请将此打印墨盒返还给 Lexmark 进行再制造、再填充或再循环。

2 只在 Lexmark 网站上提供：www.lexmark.com。

注意：

• 如要获取更多的墨水，请订购高容量打印墨盒。

• 根据您所在的国家或地区，您收到的打印墨盒可能是单独的或者带有多个包装。

• 根据您的需要，您可以组合订购标准打印墨盒和高容量打印墨盒。

• 如要获取可打印页数的信息，请访问 www.lexmark.com/yields。

• 用来打印文档的打印墨盒也可以用来打印照片。

• 要获得最佳效果，请仅使用原装 Lexmark 打印墨盒。

订购和更换耗材 11
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使用原装 Lexmark 打印墨盒
Lexmark 打印机、打印墨盒和照片纸互相配合，可以实现卓越的打印质量，并且我们的墨水专为您的打印机
设计，有助于延长您的产品的寿命。我们推荐您只使用原装 Lexmark 打印墨盒。

Lexmark 质量保证不负责修复由非 Lexmark 墨水或打印墨盒所引起的损坏。

更换打印墨盒
在您开始操作之前，请确认您有新的打印墨盒。在您取出旧的打印墨盒之后，必须立刻安装新的打印墨盒，否
则打印头喷头中剩余的墨水可能会干燥。

取出打印墨盒

1 打开打印机电源。

2 打开打印机。

注意：打印头将会移动到打印墨盒安装位置。

3 按释放按钮，然后取出旧的打印墨盒。

1 2

安装打印墨盒

1 从包装内取出打印墨盒，然后从打印墨盒上取下保护盖。

订购和更换耗材 12



如果您的墨盒带有套盖，请取下套盖。

1 2 3

2 装入各打印墨盒。沿打印墨盒边缘滑动手指，直到打印墨盒咔嗒 一声，卡入到位。

2

1

3

注意：

• 请先插入彩色打印墨盒，然后再插入黑色打印墨盒。

• 取下保护盖后请立刻插入新的打印墨盒，以避免墨水暴露在空气中。

3 关闭打印机。

订购纸张和其他耗材
如要订购打印机耗材，或者查找您附近的经销商，请访问我们的国际互联网站 www.lexmark.com。

项目： 产品编号：

USB 电缆 1021294

如要获取更多的信息，请访问网站 www.lexmark.com。

订购和更换耗材 13
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纸张： 纸张尺寸：

Lexmark 照片纸 • Letter

• A4

• 4 x 6 英寸

• L

Lexmark PerfectFinish 照片纸 • Letter

• A4

• 4 x 6 英寸

• L

注意：

• 在不同的国家／地区可能会有所不同。

• 要获得最佳效果，当您打印照片或其他高质量的图像时，请使用 Lexmark 照片纸或 Lexmark PerfectFinishTM 照片
纸。

• 如要获取更多的信息，请访问网站 www.lexmark.com。

回收 Lexmark 产品
如要返还 Lexmark 产品进行回收：

1 访问我们的国际互联网站 www.lexmark.com/recycle。

2 查找您希望回收的产品类型，然后从列表中选择您的国家或地区。

3 按照计算机屏幕上的指导进行操作。

注意：如果是未列在 Lexmark 收集计划中的打印机耗材和硬件，您可以通过当地的回收中心进行回收。请联
系您当地的回收中心以确定他们接受的回收物品。

订购和更换耗材 14
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使用打印机操作面板按钮和菜单

使用打印机控制面板

9101112

1 3 4 5 6 7 82

项目 用途

1 电源 • 打开或关闭打印机的电源。

• 切换到“睡眠”模式。

注意：打开打印机后，请按  切换到彩色模式。按住  三秒以关闭打印
机。

2 显示屏

注意：在“睡眠”模式下，
显示屏将关闭。

显示：

• 打印机状态

• 信息

• 菜单

3 箭头按钮 浏览显示屏上的菜单项。

4 选项

OK

• 选择菜单选项。

• 保存设置。

5 主页 返回到主界面。

6 彩色 切换到彩色模式。

7 黑色 按切换到黑白模式。

8 开始 根据所选模式开始作业。

9 取消 • 取消正在进行的打印、复印或扫描作业。

• 清除当前设置或错误信息，并恢复为先前的设置。

10 Wi‑Fi 指示灯 检查打印机无线连接的状态
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项目 用途

11 Eco 模式 • 打印机在空闲 10 分钟之后进入睡眠模式。

• 降低屏幕亮度。

12 返回 • 返回到上一个界面。

• 从当前菜单退出到上一级菜单。

更改睡眠时限
打印机将会在空闲一段时间之后进入睡眠模式，这段空闲时间称为睡眠时限。“睡眠”功能可降低打印机功
耗，从而优化能效。如要最多地节约能源，请选择最小的睡眠时限。

1 在打印机操作面板上依次选择：

 > 设置 > OK  > 设备设置 > OK  > 睡眠 > OK

2 按上下箭头按钮进行选择或使用数字符号键区输入睡眠时限值，然后按 OK 。

节约纸张和能源
要显著减少用纸、降低浪费，请激活双面打印：

1 在打印机操作面板上依次选择：

 > 设置 > OK  > 打印模式设置 > OK  > 双面复印，单机 > OK

2 反复按上下箭头按钮选择开，然后按 OK 。

要使能源效率达到最优化，请降低“睡眠”时限和“屏幕亮度”：

1 在打印机操作面板上依次选择：

 > 设置 > OK  > 设备设置 > OK  > 睡眠 > OK

2 反复按上下箭头按钮进行选择，或使用数字符号键区输入睡眠时限值，然后按 OK 。

3 在打印机操作面板上依次选择：

 > 设置 > OK  > 设备设置 > OK  > 屏幕亮度 > OK

4 反复按上下箭头按钮选择“暗”，然后按 OK 。

注意：如果选择了“双面复印，单机”，根据您的打印机型号，打印机会针对复印、传真作业以及 Windows
和 Macintosh 中的打印作业在纸张的双面进行打印。

恢复出厂默认设置
恢复出厂默认设置将会删除您所选择的所有打印机设置。

1 在打印机操作面板上依次选择：

 > 设置 > OK  > 恢复出厂默认设置 > OK

2 按上下箭头按钮选择“恢复所有打印机设置”，然后按 OK 。

使用打印机操作面板按钮和菜单 16



3 按左右箭头按钮选择“是”，然后按 OK 。

恢复出厂默认设置之后，打印机将自动重新启动。

4 当提示您设置打印机初始设置时，请使用打印机操作面板上的按钮进行选择。

显示屏上将会出现“初始设置完成”。

使用打印机操作面板按钮和菜单 17



使用打印机软件

最低系统需求
打印机软件最多需要 500MB 可用硬盘空间。

支持的操作系统
• Microsoft Windows 7 (SP1)

• Microsoft Windows Server 2008 (R2 SP1)

• Microsoft Windows Server 2008 (SP1)

• Microsoft Windows Server 2003 (SP2)

• Microsoft Windows Vista (SP1)

• Microsoft Windows XP (SP3)

• Macintosh Intel OS X version 10.7.0 或更高版本（英文版）

• Macintosh Intel OS X version 10.6.0 或更高版本（英文版）

• Macintosh Intel OS X version 10.5.0 或更高版本（英文版）

• Macintosh Intel OS X version 10.4.4 或更高版本（英文版）

• Macintosh PowerPC OS X version 10.5.0 或更高版本（英文版）

• Macintosh PowerPC OS X version 10.4.0 或更高版本（英文版）

• Ubuntu Linux 11.04、10.10、10.04 和 9.04 LTS*

• Red Hat Enterprise Linux WS 6、WS 5 和 WS 4*

• Red Flag Linux Desktop 6.0*

• SUSE Linux Enterprise Server 11 和 10*

• SUSE Linux Enterprise Desktop 11 和 10*

• Linux openSUSE 11.4、11.3 和 11.2*

• Linpus Linux Desktop 9.6*

• Fedora 14*

• Debian GNU/Linux 6.0 和 5.0*

• Mint 10 和 9*

• PCLinux OS 2010*

* 适用于此操作系统的打印机驱动程序只能从下面的网站上获得：http://support.lexmark.com。

使用 Windows 打印机软件

在打印机安装过程中安装的软件

当您使用安装软件光盘安装打印机时，所有必需的软件都已经安装。您可能也选择了安装一些其他的程序。下
面的表格提供了各种软件程序的概述，以及它们可以帮助您做什么。

+如果您在初始安装过程中没有安装这些程序，请重新插入安装软件 CD，运行安装软件，然后单击高级选项 >
安装其他软件。

使用打印机软件 18
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打印机软件

使用 以便

LexmarkTM 打印机主页

（简称为打印机主页）

• 运行应用程序。

• 扫描或通过电子邮件发送照片或文档。

• 编辑扫描的文档。

• 将文档扫描成 PDF 格式。

• 调整打印机设置。

• 订购耗材。

• 维护打印墨盒。

• 注册打印机。

• 联系技术支持。

• 访问用户手册。

Lexmark 电话簿

（简称为电话簿）

管理传真联系人。

Abbyy Sprint OCR 扫描文档并生成您可以在文字处理程序中编辑的文本。

Lexmark 无线设置实用程序

（简称为无线设置实用程序）

• 在无线网络中安装无线打印机。

• 改变打印机的无线设置。

注意：如果打印机有无线功能，此程序将会随同打印机软件一起自动安装。

Lexmark Tools for Office
（Office 工具）

（简称为 Tools for Office）

在 Microsoft Office 2007 中读取您喜欢的设置。

打印机设置实用程序 配置打印机的传真和电子邮件设置。

状态报告器 了解更多关于遇到的打印问题的信息

状态监控中心 • 检查打印机耗材的状态

• 在线订购耗材。

产品升级 有新的更新可用时，接收打印机软件更新的自动通知。

打印首选项 当您打开一个文档，然后单击文件 >打印 >属性时，打印首选项对话框将会出现。您可
以在对话框中为打印作业选择选项，例如：

• 选择要打印的份数。

• 进行双面打印。

• 选择纸张类型。

• 添加水印。

• 增强图像。

• 保存设置。

注意：打印首选项随同打印机软件一起自动安装。

注意：根据您购买的打印机的功能，您的打印机可能不提供某些程序，或者不支持程序的某些功能。

使用 Macintosh 打印机软件

启动打印对话框。

使用打印对话框调整打印设置和预先安排打印作业。
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打开文档或照片后，选择 File > Print。

启动应用程序

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击要使用的应用程序。

选项 用途

Printer Settings（打印机设置） • 定制传真作业设置。

• 创建和编辑联系人列表。

• 配置电子邮件连接设置。

• 配置语言、国家/地区、日期和时间。

Shortcuts（快捷方式） 快速执行打印机常用任务。

Wireless Setup Assistant（无线设置
助手）

在无线网络中安装打印机。

注意：如果打印机有无线功能，此应用程序将会随同打印机软件一起自动安装。

Uninstaller（卸载程序） 从计算机中删除打印机软件。

注意：

• 根据您购买的打印机的功能或安装打印机时所选的安装类型（标准或自定义），您的打印机可能不包含
这些应用程序。

• 要利用打印机的完整功能，安装时请选择自定义安装选项，然后选择列出的所有安装包。

访问 Web 链接

链接到预定义的 Web 页面的 Web 链接保存在打印机文件夹中。

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹 > Web Links

2 双击要访问的 Web 链接。

项目 用途

客户支持 联系客户支持。

Lexmark Software Updates（Lexmark 软件更新） 下载并安装最新的打印机软件。

Lexmark Online（Lexmark 在线） 访问 Lexmark 网站。

Order Supplies Online（在线订购耗材） 订购墨水或耗材。

Printer Registration（打印机注册） 注册您的打印机。

Visit Lexmark SmartSolutions（访问 Lexmark SmartSolutions） • 访问 SmartSolutions 网站。

• 选择您的自定义解决方案。

注意：打印机可能未带有这些 Web 链接，取决于您购买的打印机的功能。
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查找并安装可选软件

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 >支持 > 在线支持

4 从网站选择您的打印机，然后下载驱动程序。

5 安装其他或可选软件。

对于 Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹 > Web Links > Lexmark Software Updates

2 从网站选择您的打印机，然后下载驱动程序。

3 安装其他或可选软件。

更新打印机软件

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 选择您的打印机，然后单击产品更新。

4 按照计算机屏幕上的指示进行操作。

对于 Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹 > Web Links > Lexmark Software Updates

2 从网站选择您的打印机，然后下载驱动程序。

下载 PCL 和 PS 驱动程序（仅限于 Windows）
可从我们的网站下载通用的打印驱动程序（例如 PCL 5 仿真、PCL XL 仿真和 PS 仿真）。您需要搜索打印机
型号以查看兼容的驱动程序。
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重新安装打印机软件
当您使用安装软件光盘安装打印机时，所有必需的软件都应该已经安装。如果您在安装过程中遇到了问题、您
的打印机没有出现在打印机文件夹中、或者发送打印作业时您的打印机没有出现在打印机选项中，请尝试卸载
并重新安装打印机软件。

反安装打印机软件

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 单击反安装程序。

4 按照计算机屏幕上的指示进行操作。

5 完成反安装后，请重新启动计算机。

对于 Macintosh（英文版）用户

1 关闭所有打开的应用程序。

2 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

3 双击 Uninstaller。

4 按照计算机屏幕上的指示进行操作。

安装打印机软件

注意：如果您以前在这台计算机上安装了打印机软件，但是需要重新安装软件，请先卸载当前的软件。

对于 Windows 用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

如果 1 分钟之后安装对话框界面仍然没有显示，请手动运行光盘：

a 单击 ，或单击开始 ，然后单击运行。

b 在“开始搜索”或“运行”框中，键入 D:\setup.exe，其中 D 是 CD 或 DVD 驱动器的盘符。

c 按输入，或单击好。

3 单击安装，然后按照计算机屏幕上的指导进行操作。
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对于 Macintosh 用户

注意：要利用打印机的完整功能，请选择定制安装选项，然后选择列出的所有安装包。

1 关闭所有打开的应用程序。

2 插入安装软件光盘。

如果 1 分钟之后安装对话框仍未出现，请单击计算机桌面上的光盘图标。

3 双击软件安装程序包，然后按照计算机屏幕上的指导进行操作。

使用 Internet

1 访问 Lexmark 网站，网址为：http://support.lexmark.com。

2 依次选择：

支持与下载 > 选择您的打印机 > 选择您的操作系统。

3 下载驱动程序并安装打印机软件。

使用打印机软件 23

http://support.lexmark.com


装入纸张和文档原件

加载纸张
1 前后弯曲纸张，使它们松散。

不要折叠或弄皱纸张。在一个平坦表面上将整摞纸张的边缘对齐。

2 打开进纸保护盖。

3 将纸张放在纸张支架的中心。

注意：装载尺寸较小的纸张时，使用纸张支架上的标记。

4 调节进纸导轨，使之紧靠纸张的边缘。

1 2

注意：请不要用力将纸张塞入打印机内。纸张应该平整地放置在纸张支架的表面上，并且纸张的边缘应
该紧靠两边的进纸导轨。
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5 打开进纸保护盖。

6 在打印机操作面板上选择或确认您的纸张设置。

纸张和特殊介质指导

最多可以装入 请确认

100 张普通纸

1 2

• 进纸导轨紧靠纸张的边缘。

• 如要装入印有页眉的信纸，请确认要打印的一面朝上，然后将信纸的顶
端装入打印机内。

25 张重磅亚光纸 • 要打印的一面朝上。

• 进纸导轨紧靠纸张的边缘。

注意：高速模式可以选择，但是不推荐用于比较贵的纸张，例如重磅亚光
纸、标签纸、照片卡和光面纸。

10 个信封

2
1

• 信封的打印面向上，信封舌面向左。

• 进纸导轨紧靠信封的边缘。

1
2

• 请在纸张支架的中心装入信封。

• 选择正确的信封尺寸。如果没有列出完全合适的信封尺寸，请选择下一
个最大的尺寸。

• 请使用“横向”设置打印信封。

警告—可能的损坏：请不要使用带有金属扣、线绳或金属折杆的信封。

注意：

– 请不要装入带有孔洞、穿孔、剪贴或阳文的信封。

– 请不要使用带有外露粘胶的信封。
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最多可以装入 请确认

25 张标签纸 • 要打印的一面朝上。

• 进纸导轨紧靠纸张的边缘。

注意：高速模式可以选择，但是不推荐用于比较贵的纸张，例如重磅亚光
纸、标签纸、照片卡和光面纸。

25 张贺卡专用纸、索引卡、明信片或照片
卡

2
1

• 要打印的一面朝上。

• 请在进纸匣的中心装入照片纸。

• 进纸导轨紧靠卡片纸的边缘。

注意：

– 要获得最佳效果，请将照片单独放置至少 24 小时，等墨水完全干燥后
再进行叠放、展示或储存。

– 高速模式可以选择，但是不推荐用于比较贵的纸张，例如重磅亚光纸、
标签纸、照片卡和光面纸。

25 张照片／光面纸 • 可打印的一面或光滑的一面朝上装入。如果您不确定哪一面可打印，请
参阅纸张随附的说明。

• 进纸导轨紧靠纸张的边缘。

• 请不要 接触或刮擦未打印的纸张的光面，以防止出现可能影响打印质量
的污迹或痕迹。

注意：

– 要获得最佳效果，请将照片单独放置至少 24 小时，等墨水完全干燥后
再进行叠放、展示或储存。

– 高速模式可以选择，但是不推荐用于比较贵的纸张，例如重磅亚光纸、
标签纸、照片卡和光面纸。

10 张热转印纸 • 请按照包装上的指导装入热转印纸。

• 要打印的一面朝上。

• 进纸导轨紧靠热转印纸的边缘。

注意：要获取最佳效果，请一次装入一张热转印纸。

50 张透明胶片 • 粗糙的一面朝上。

• 进纸导轨紧靠透明胶片的边缘。

• 装入之前请撕去透明胶片的纸质背面。

• 您可装入 A4 或 letter 尺寸的透明胶片。

• 如果透明胶片具有可撕除条带，那么每个条带都要朝上。

注意：透明胶片需要较长的时间才能完全干燥。为了避免出现污迹，请立
即取出打印机送出的透明胶片，等墨水完全干燥后再进行叠放或储存。
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保存纸张设置
您可以调整打印机和复制作业的设置，使之与您在打印机中装入的纸张尺寸和类型匹配。

1 按打印机操作面板上的 。

2 根据您的需要调整设置：

• 如果您希望设置纸张尺寸，请依次选择：

设置 > OK  > 纸张设置 > OK  > 纸张尺寸 > OK  > 选择默认纸张尺寸 > OK

• 如果您希望设置纸张类型，请依次选择：

设置 > OK  > 纸张设置 > OK  > 纸张类型 > OK  > 选择默认纸张类型 > OK

将文档原件放置在扫描仪玻璃上
1 打开扫描仪顶盖，然后将文档原件正面朝下放置在扫描仪玻璃上。

2 关闭扫描仪顶盖。
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打印

打印提示
• 请使用适合打印作业的合适纸张。

• 请选择高打印质量以获得更好的打印结果。

• 请确认打印墨盒中有足够的墨水。

• 在打印照片或使用特殊介质时，请在每打印完一张后立即取走。

• 请不要 在打印过程中触摸一个或多个双面锁。

打印基本文档

打印文档

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 选择打印质量、打印份数、纸张类型和如何打印页面。

4 单击确定以关闭打印机软件的所有对话框。

5 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项菜单中选择打印质量、打印份数、纸张类型和如何打印页面。

7 单击 Print。
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逐份打印

当您将一份文档打印多份时，您可以选择分别打印每一份（逐份）或者按照页数一组一组地打印（不逐份）。

逐份 不逐份

注意：

• 只有当您打印多份文档时，逐份打印选项才可用。

• 当您打印照片时，为了避免出现污迹，请随时移开打印机送出的照片，等墨水完全干燥后再进行叠放。

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

布局选项卡 > “份数”区域

4 输入您希望打印的份数，然后选中逐份打印。

5 单击确定以关闭打印机软件的所有对话框。

6 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 在 Copies 区域中输入您希望打印的份数，然后选择 Collated。

7 单击 Print。

更改页面的打印顺序

对于 Windows 用户

1 打开文档，从应用程序中单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

布局选项卡 >“份数”区域

4 如要更改当前页面顺序，请选中倒序打印复选框。
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5 单击确定以关闭打印机软件的所有对话框。

6 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中选择 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从 Print Options 弹出菜单中选择 Paper Handling。

7 从 Page Order 弹出菜单中选择页面顺序：

• 如要先打印第一页，请选择 Normal。

• 如要先打印最后一页，请选择 Reverse。

8 单击 Print。

将多页文档打印到一张纸上

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

布局选项卡 >页面布局区域 >选择一面多页（合并打印）

4 选择您希望在每面纸上合并打印的页面图像数。

5 根据您的需要调整其他设置。

6 单击确定以关闭打印机软件的所有对话框。

7 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项弹出菜单中选择 Layout。

7 从 Pages per Sheet 弹出菜单中选择在每一张纸上合并打印的文档页数。
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8 根据您的需要调整其他设置。

9 单击 Print。

在特殊介质上打印

打印信封

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

纸张/修饰选项卡 >纸张尺寸列表 >选择您的信封尺寸。

如果没有完全符合的纸张尺寸，请单击管理自定义尺寸并设置自定义尺寸。

4 依次选择：

纸张类型列表 >选择信封

5 依次选择：

布局选项卡 >页面方向区域 >选择方向

6 单击确定以关闭打印机软件的所有对话框。

7 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择您的信封尺寸。

如果没有完全符合的信封尺寸，请选择自定义尺寸。

4 选择打印方向，然后单击 OK。

5 从菜单栏中单击 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

7 单击 Print。

注意：

• 多数信封使用横向打印。

• 请确认您在应用程序中选择了相同的打印方向。
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在标签上打印

注意：

• 请确认标签纸的顶部首先装入打印机内。

• 请确认标签纸上的粘性部分距离纸张的边缘至少 1 毫米。

• 请确认进纸导轨紧靠标签纸的边缘。

• 请使用完整的标签纸。如果标签纸不完整（缺少部分标签），在打印过程中可能会脱落，从而导致卡
纸。

对于 Windows 用户

1 打开文档，从应用程序中单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

纸张/修饰选项卡 > 管理自定义尺寸 > 新建

4 输入名称并按需要调整设置，然后单击确定。

5 依次选择：

纸张类型列表 > 选择创建的自定义类型

6 单击确定以关闭打印机软件的所有对话框。

7 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择您的纸张尺寸。

如果没有完全符合的纸张尺寸，请设置自定义尺寸。

4 选择打印方向，然后单击 OK。

5 从菜单栏中选择 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

7 从 Print Options 弹出菜单中选择 Quality & Media。

8 从 Paper Type 弹出菜单中选择 Labels。

9 从 Print Quality 弹出菜单中选择除 Quick Print 或 Draft 以外的其他打印质量。

10 单击 Print。

打印自定义尺寸的纸张

对于 Windows 用户

1 打开文档，单击文件 > 打印。

2 单击属性、首选项、选项或设置。
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3 依次选择：

纸张/修饰选项卡 >管理自定义尺寸 >新建

4 输入名称并按需要调整设置，然后单击确认。

5 单击关闭，然后单击确认以关闭所有打印机软件对话框。

6 单击确定或打印。

对于 Macintosh（英文版）用户

1 打开文档，选择 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择 Manage Custom Sizes。

4 按需要调整设置以创建自定义尺寸，然后单击 OK。

5 单击 OK。

6 从菜单栏中单击 File > Print。

7 从 Printer 弹出菜单中选择您的打印机。

8 单击 Print。

打印照片

支持的文件类型
• .jpg、.jpeg,、.jpe (Joint Photographic Experts Group)

• .tiff、.tif (Tagged Image File Format)

将闪存驱动器与打印机一起使用

确保闪存驱动器包含打印机支持的文件。如要获取更多的信息，请参阅第 33 页“支持的文件类型”。

1 将闪存驱动器插入 USB 端口。

F
L
A
S
H
 D

R
IV
E

注意：

• 闪存驱动器与 PictBridge 相机电缆使用同一端口。

• 如果您的闪存驱动器无法直接插入端口，那么必须使用适配器。
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警告—可能的损坏：从存储设备进行打印、读取或写入时，切勿触摸区域中所
示的任何电缆、网络适配器、连接器、存储设备或打印机。可能会发生数据丢
失。

2 按照打印机显示屏上的指导进行操作，或从可用选项中进行选项。

注意：如果打印机无法识别存储设备，请将其取出并重新插入。

从闪存驱动器打印照片

1 装入照片纸。

2 插入闪存驱动器或设置为大容量存储器模式的数码相机。

3 使用上下箭头按钮选择打印照片选项，然后按 OK 。

• 通过“选择并打印”，您可以选择布局、每页的照片数、纸张设置、照片尺寸、照片质量并且可以增强
图像的锐度质量。

• 通过“打印照片”，您可以打印全部照片、按照照片范围打印所选的照片以及使用预设照片尺寸模板打
印照片。

4 如要调整打印设置，请按上下箭头按钮选择要设置的选项，然后按左右箭头按钮选择希望的设置。如有必

要，请按 OK 进行选择。

5 按 按钮。

注意：要获得最佳效果，请将打印页单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储
存。

从 PictBridge 兼容数码相机中打印照片

大部分数码相机都支持 PictBridge 技术，可以允许您直接从数码相机中打印照片，无需连接计算机。

1 将 USB 电缆的一端连接在数码相机上。

注意：请仅使用数码相机随附的 USB 电缆。

2 将 USB 电缆的另一端插入打印机前面的 PictBridge 接口中。
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注意：

• 请确认将数码相机设置为正确的 USB 模式。如果 USB 选择不正确，可能会将数码相机检测为一个闪
存驱动器，或者打印机操作面板上可能会显示错误信息。如需更多信息，请参阅数码相机随附的文
档。

• 打印机每次只能读取一种存储设备。

警告—可能的损坏：从存储设备进行打印、读取或写入时，切勿触摸区域中所
示的任何开放式连接器、存储设备或打印机。可能会发生数据丢失。

3 如果 PictBridge 连接成功，显示屏上将会出现以下信息：使用 PictBridge设备进行选择并打印照片。
按“确定”以选择打印机默认设置。

4 如果您希望更改默认打印设置：

a 按 OK 进入 PictBridge 菜单。

b 反复按箭头按钮选择纸张来源、纸张设置、照片尺寸、每页的照片数以及打印质量。您也可以增强图像

质量。选择完每一项之后请按 OK 。

注意：除非您在数码相机中更改打印设置，否则打印机将使用默认打印设置。

5 请参阅数码相机随附的文档以开始进行打印。

注意：当打印机正在打印其他作业时，如果您连接了 PictBridge 兼容数码相机的 USB 电缆，请等待作业完
成，然后再从数码相机中进行打印。

在纸张的双面进行打印（双面打印）

自动在纸张的双面进行打印

注意：

• 自动双面复印部件支持 A4 和 letter 尺寸的纸张。此外还支持普通纸、优质普通纸、通过 ColorLok 认证
的普通纸、重磅普通纸和信纸。

• 不要 在打印完成之前移开页面。

警告—可能的损坏：不要 在打印过程中触摸一个或多个双面锁。

对于 Windows 用户

1 打开文档后，单击文件 > 打印。

2 单击属性、首选项、选件或设置图标。

3 依次选择：
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布局 选项卡 > 在双面区域打印 > 双面复印

• 单击长边 以打印页面长边为装订边的打印作业。

• 单击短边 以打印页面短边为装订边的打印作业。

4 单击纸张/完成 标签，然后选择支持的纸张类型。

5 单击确定 以关闭打印机软件的所有对话框。

6 单击确定 或者打印。

要返回单面打印，请重复步骤 1 和步骤 2，然后依次选择：

布局 选项卡 > 在双面区域打印 > 仅在一面打印

对于 Macintosh 用户

1 打开文档后，选择 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中选择 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项弹出菜单中选择 Quality & Media。

7 从 Paper Type 弹出菜单中选择支持的纸张类型。

8 从打印选项弹出菜单中选择 Layout。

9 从“双面”弹出菜单中选择 Long‑Edge binding 或者 Short‑Edge binding。
• 如果选择了 Long‑Edge binding，页面将会沿着长边打印（纵向打印沿着左边，横向打印沿着顶边）。

Portrait Landscape

1
2 1

2

• 如果选择了 Short‑Edge binding，页面将会沿着短边打印（横向打印沿着左边，纵向打印沿着顶边）。

Portrait Landscape

10 单击 Print。
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设置双面打印干燥时间

使用操作面板

1 在打印机操作面板上依次选择：

 > 设置 > OK  > 打印模式设置 > OK  > 页面干燥时间 > OK

2 按上下箭头按钮选择您希望的干燥时间，然后按 OK 。

注意：根据您为打印作业所选择的打印质量，干燥时间会有所不同。选择延长可以延长打印干燥时间。

使用打印机软件

对于 Windows 用户

1 单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

布局选项卡 > 双面打印区域 > 选择干燥时间设置

注意：在高湿度条件下，或者如果正常干燥时间不足以让墨水完全干燥，请选择延长。

4 单击确定。

对于 Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax > 选择您的打印机

2 依次选择：

Open Print Queue > Printer Setup > Driver 选项卡

或者

Printer Setup > Installable Options

3 从 Two‑Sided Printing Dry Time 弹出菜单中选择干燥时间设置。

注意：在高湿度条件下，或者如果正常干燥时间不足以让墨水完全干燥，请选择 Extended。

4 单击 OK 或 Apply Changes。

管理打印作业

查找打印机的打印队列

打印队列代表连接到您的计算机上的打印机。打印队列名称通常是安装或添加打印机时分配的打印机型号或打
印机别名。

注意： 根据打印机连接到计算机的方式（USB、以太网或无线），列表中可能会显示数个打印队列。确保
您知道打印机连接到计算机的方式以便选择正确的打印队列。
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对于 Windows 用户

1 打开打印机文件夹。

a 单击 ，或单击开始，然后单击运行。

b 在“开始搜索”或“运行”框中输入控制打印机。

c 按输入键，或者单击确定。

2 为您的打印机查找打印对列（网络或 USB）。

3 如果列表中没有该打印队列，那么请创建新的打印队列。

对于 Macintosh（英文版）用户

1 从 Apple 菜单依次选择：

System Preferences > Print & Fax >选择您的打印机打印序列

2 如果列表中没有该打印队列，那么请创建新的打印队列。

创建打印队列

对于 Windows 用户

1 从“打印机任务”区域中单击添加打印机。

2 按照计算机屏幕上的指示进行操作。

请参阅您的操作系统的帮助文档获取更多的信息。

对于 Macintosh（英文版）用户

1 在“Print & Fax”区域中单击+。

2 按照需要单击 Default 或 Default Browser 选项卡。

3 从列表中选择打印机。

注意：连接到网络的打印机或通过 USB 连接线连接的本地打印机可能拥有相同的默认打印机名称。如果
必要，请使用“Name”字段来重新命名打印机。

4 单击 Add。

将您的打印机设置为默认打印机

当您发送打印作业时，您的打印机应该在“打印”对话框中自动被选中。如果您必须手动选择您的打印机，说
明您的打印机不是默认打印机。

如要设置默认打印机：

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后单击“设为默认打印机”。
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Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax

2 从 Default Printer 弹出菜单中选择打印机，或者选择打印机，然后单击 Make Default。

改变默认打印模式

如要节省墨水，您可以为所有打印作业将默认打印模式改变为“草稿”或“高速”。此模式可以使用较少的墨
水，建议用于打印纯文本文档。如果您要打印照片或其他高质量的文档，并且需要改变为不同的打印模式，您
可以在发送打印作业之前在“打印”对话框中选择不同的模式。

对于 Windows 用户

1 打开文档，从应用程序中单击文件 >打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

质量 选项卡 > 选择打印质量 > 确定

对于 Macintosh（英文版）用户

1 打开文档，依次选择 File > Print。

2 从 Printer 弹出菜单中选择您的打印机。

3 从打印选项弹出菜单中选择 Quality & Media。

4 从 Print Quality 弹出菜单中选择打印质量。

5 单击 OK。

暂停打印作业

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 暂停打印作业：

• 如果您希望暂停特定的打印作业，请右键单击文档名，然后单击“暂停”。

• 如果您希望暂停队列中所有的打印作业，请单击“打印机”菜单，然后选中“暂停打印”。
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Macintosh（英文版）用户

1 单击 dock 上的打印机图标。

打印队列对话框将会出现。

2 暂停打印作业：

• 如果您希望暂停特定的打印作业，请选择文档名，然后单击 Hold。

• 如果您希望暂停队列中所有的打印作业，请单击 Pause Printer 或 Stop Jobs。

继续打印作业

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 继续打印作业：

• 如果您希望继续特定的打印作业，请右键单击文档名，然后单击“继续”或“重新启动”。

• 如果您希望继续队列中所有的打印作业，请单击“打印机”菜单，然后取消选中“暂停打印”。

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax > 选择您的打印机

2 单击 Open Print Queue 或 Set Up Printers。

打印队列对话框将会出现。

3 继续打印作业：

• 如果您希望继续特定的打印作业，请选择文档名称，然后单击 Resume。

• 如果您希望继续队列中所有的打印作业，请单击 Resume Printer 或 Start Jobs。

取消打印作业

如要取消从打印机操作面板开始的打印作业，请按  按钮。如要取消从计算机开始的打印作业，请根据您的
操作系统选择操作：

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。
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5 取消打印作业：

• 如果您希望取消特定的打印作业，请右键单击文档名，然后单击“取消”。

• 如果您希望取消队列中所有的打印作业，请单击“打印机 > 取消所有文档”。

Macintosh（英文版）用户

1 单击 dock 上的打印机图标。

打印队列对话框将会出现。

2 选择您希望取消的作业，然后单击 Delete。

从移动设备打印

什么是 LexPrint？
LexPrint 是一款免费的应用程序，让您可以通过 Lexmark 打印机轻松打印来自同一无线网络中的 iPad、iPhone
或 iPod touch 中的内容。也可以打印网页、相册中的照片，或者近期通过移动设备的数码相机拍摄的照片（具
体取决于其功能）。还可定制移动设备中的打印设置。

根据您的 Lexmark 打印机型号，您可能需要从我们的网站下载 LexPrint Listener 应用程序：
www.lexmark.com/lexprint。

支持的打印机

LexPrint 让您的移动设备可与同一网络中的 Lexmark 打印机进行通讯。

• 对于支持 Direct Image 以及 Zeroconf 或 Bonjour 的精选打印机型号，您可以直接从移动设备向打印机进
行打印，而不需使用 LexPrint Listener。如要查看您的打印机型号是否支持上述功能，请访问
www.lexmark.com/lexprint。

• 对于其他型号的 Lexmark 打印机，只要与之相连的计算机上安装有打印机软件和 LexPrint Listener，您
便可使用移动设备向打印机发送打印作业。

注意：该应用程序以前在 Mac OS X version 10.2 中称作 Rendezvous，现由 Apple Inc.命名为 Bonjour。
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复印

扫描仪玻璃

将文档原件正面朝下放置在扫描仪的放置角落。

注意：自动文档传送器 (ADF) 仅在精选打印机型号上可用。

复印提示
• 请确保将源文档或照片面朝下装载到扫描仪玻璃或放置角落上。请不要在 ADF 内装入明信片、照片、较小
的物体、透明胶片、照片纸或较薄的介质（例如杂志剪辑）。

• 如果可能，请关闭扫描仪顶盖，避免在扫描的图像上留下黑边。

• 请确保出纸托盘完全展开。

• 设置好要扫描的文档后，请按  开始复印。

进行复印
1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 在打印机操作面板上依次选择：

 > 复印 > OK  > 份数

4 反复按左右箭头按钮选择复印份数。

5 从“复印”菜单屏幕中，反复按上下箭头按钮选择要设置的选项，然后反复按左右箭头按钮选择希望的设

置。如有必要，请按 OK 进行选择。

6 选择复印模式：

• 按 切换到彩色模式。

• 按 切换到黑白模式。
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当您选择仅彩色或仅黑白打印时，与您的选择相应的指示灯将会变亮。

7 按 。

注意：打印机处于不活动状态超过 2 分钟后，选定复印设置将重置为出厂默认设置。

复印 ID 卡
1 装入 A4 或 Letter 尺寸的普通纸。

2 从打印机操作面板，依次选择：

 > 复印 > OK  > ID 卡复印

3 按 ，然后将 ID 卡正面朝下放置在扫描仪玻璃的角落。

4 按 。

5 如果提示复制 ID 卡的背面，请按左右箭头按钮选择“是”，然后按 OK 。

6 将 ID 卡的背面朝下放置在扫描仪玻璃的角落，然后按 。

放大或缩小图像
1 装入纸张。

2 将文档原件正面朝下放置在扫描仪玻璃上。

3 在打印机操作面板上依次选择：

 > 复印 > OK  > 缩放

4 反复按左右箭头按钮选择您希望的“缩放”设置。

注意：

• 如果您选择了“自定义百分比”，请按 OK ，然后反复按左右箭头按钮选择自定义百分比数值。按 OK

保存设置。

• 如果您选择了“无边界”，打印机将会根据需要自动缩小或放大文档或照片，在您所选择的纸张尺寸
上进行无边界打印。为了达到此设置的最佳效果，请使用照片纸并将纸张类型设置为“照片”。

• 如果您选择了“适合页面”，打印机将会适当调整文档或照片的大小，使之适合单页纸。

5 按 。

调整复印质量
1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 在打印机操作面板上依次选择：

 > 复印 > OK  > 质量

4 反复按左右箭头按钮设置复印质量。

5 按 。
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使复印效果变浅或者加深
1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 从打印机操作面板，依次选择：

 > 复印 > OK  > 深浅

4 反复按左右箭头按钮调整打印深浅。

• 按左箭头按钮可以使复印效果变浅。

• 按右箭头按钮可以使复印效果较深。

5 按 。

使用打印机操作面板进行逐份复印
如果要打印多份文档，可以选择分别打印每一份（逐份）或者按照页数一组一组地打印（不逐份）。

逐份 不逐份

1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 在打印机操作面板上依次选择：

 > 复印 > OK  > 份数

4 按左右箭头按钮选择复印份数。

5 反复按上下箭头按钮直到出现“逐份”。

6 按左右箭头按钮选择“开”，然后按 。

在复印件间插入分隔页
分隔页是根据所选设置在页数、复印数或作业数之间所放的一张纸。该功能在打印透明胶片时非常有用。

1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 在打印机操作面板上依次选择：

 > 复印 > OK  > 分隔页

注意：要在复印件间插入分隔页，必须将“逐份打印”设置为“开”。如果“逐份打印”设置为
“关”，那么分隔页将添加到打印作业的末尾。

4 按左右箭头按钮选择分隔页设置，然后按 。
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将多页文档复印到一张纸上
您可以通过打印每个页面缩小后的图像，将多个页面复印在一张纸上。例如，如果您使用此设置在一张纸上打
印 4 页文档，可以将一份 20 页的文档减少到 5 页。

1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 在打印机操作面板上依次选择：

 > 复印 > OK  > 页/面

4 按左右箭头按钮选择纸张方向以及您希望在一张纸上复印的文档页数。您最多可以在一张纸上打印 4 页图
像。

5 按 。

在每一页上添加背景图案信息
1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 在打印机操作面板上依次选择：

 > 复印 > OK  > 背景图案

4 按左右箭头按钮选择背景图案设置。

注意：对于通过数字符号键区选择的打印机型号，请使用数字符号键区输入自定义文本背景图案，然后

按 OK 。

5 按 。

去除复印件背景
“背景去除”功能能够调整复印件上的可见背景数量。

1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 在打印机操作面板上依次选择：

 > 复印 > OK  > 背景去除

4 按左右箭头按钮选择背景去除数量。

5 按 。
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进行双面复印

自动进行双面复印

自动双面复印部件支持 A4 和 letter 尺寸的纸张。如果要使用其他纸张尺寸进行双面复印，请参阅手动进行双
面复印的指导。

注意：您不可以在信封、卡片纸或照片纸上进行双面复印。

1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 从打印机控制面板，依次选择：

 > 复印 > OK  > 双面复印

4 按左右箭头按钮选择双面复印选项：

• 如果您要复印单面的文档，请反复按箭头按钮选择 1面到 2面。

• 如果您要使用扫描仪玻璃复印单面的文档，请反复按箭头按钮选择 2面到 2面。

• 如果要指定文档原件和复印件的页面方向和布局，请反复按箭头按钮选择高级。每次选择时都按 OK  ，
然后按  ，直到打开复印菜单屏幕。

注意：

• 如果选择了长边装订，复印页面将会沿着页面的长边装订（纵向打印沿左边、横向打印沿顶边）。

• 如果选择了短边装订，复印页面将会沿着页面的短边装订（纵向打印沿顶边、横向打印沿左边）。

5 按 然后按照显示屏上的指导进行操作。

手动进行双面复印

1 装入纸张。

2 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

3 从打印机控制面板，依次选择：

 > 复印 > OK  > 份数

4 按左右箭头按钮选择复印份数。

5 在“复印”菜单屏幕中，按上下箭头按钮选择您要设置的选项，然后按左右箭头按钮选择您希望的设置。

如有必要，请单击 OK  进行选择。

6 选择复印模式：

• 按  切换到彩色模式。

• 按  切换到黑白模式。

当您选择仅彩色或仅黑白打印时，与您的选择相应的指示灯将会变亮。

7 按  在纸张的单面进行打印。
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8 装入文档的下一页。

• 如果要复印单面文档，请将下一页正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪
玻璃上。

• 如果要复印双面文档，请翻转文档原件，然后将它正面朝上装入自动文档传送器(ADF)内，或者正面朝
下放置在扫描仪玻璃上。

9 从出纸托盘中取出纸张，然后将顶边在前重新装入纸张打印文档的另外一面。

确认纸张可打印的一面朝上。

3

2

1

10 按 。

取消复印作业
要取消复印作业，请按 ，然后按 OK 。

扫描将停止，打印机将返回到前一菜单。
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扫描

扫描仪玻璃

将文档原件正面朝下放置在扫描仪的放置角落。

注意：自动文档传送器 (ADF) 仅在精选打印机型号上可用。

扫描提示
• 将文档原件正面朝下放置在扫描仪玻璃上。请不要在 ADF 内装入明信片、照片、较小的物体、透明胶片、
照片纸或较薄的介质（例如杂志剪辑）。

• 如果可能，请关闭扫描仪顶盖，避免在扫描的图像上留下黑边。

• 请确保完全展开出纸托盘且反转托盘扩展板。

• 设置好要扫描的文档后，请按  开始扫描。

扫描至本地计算机
1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 从打印机操作面板，依次选择：

 > 扫描 > OK  > 计算机 > USB 连接的计算机 > OK

默认情况下，USB 连接的计算机将接收扫描。

注意：请确认目的地计算机上装有扫描软件。

3 按上下箭头按钮选择您要设置的扫描选项，然后按左右箭头按钮选择您希望的设置。

设置颜色、质量、图像原件大小以及其他扫描选项。如有必要，请在每次选择完一项之后按 OK 。

4 按 。
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扫描至网络计算机
1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 从打印机操作面板，依次选择：

 > 扫描 > OK  > 计算机

3 反复按左右箭头按钮手动选择目标计算机的名称，然后按 OK 。

注意：

• 如果计算机要求识别码，打印机可能会提示您输入识别码。

• 如要为计算机指定计算机名和识别码，请参阅与您的操作系统相关的打印机软件帮助。

4 按上下箭头按钮选择您要设置的扫描选项，然后按左右箭头按钮选择您希望的设置。

设置颜色、质量、图像原件大小以及其他扫描选项。如有必要，请在每次选择完一个选项之后按 OK 。

5 按 。

注意：对于 Macintosh（英文版）用户，您可能需要通过 Image Capture 来启用至计算机的扫描，以便使用
网络打印机扫描文档以及保存扫描输出。

扫描至闪存驱动器或存储卡

注意：

• 只有精选打印机型号才具备其中的一些功能。

• 请确认您的闪存驱动器或存储卡没有设置写保护。

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 从打印机操作面板，依次选择：

 > 扫描 > OK  > 存储设备

3 插入闪存驱动器或存储卡，然后按 OK 。

注意：打印机每次只能读取一种存储设备。

4 按上下箭头按钮选择您要设置的扫描选项，然后按左右箭头按钮选择您希望的设置。

设置颜色、质量、图像原件大小以及其他扫描选项。如有必要，请在每次选择完一项之后按 OK 。

5 按 。

按照打印机显示屏上的指导进行操作。

扫描照片并进行编辑

对于 Windows 用户

1 将照片正面朝下放置在扫描仪玻璃上。

2 单击 或开始。

3 单击所有程序或程序，然后从列表中选择打印机程序文件夹。
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4 依次选择：

单击打印机主页 > 选择您的打印机 > 扫描

• 如果您希望扫描单张照片，或者将多张照片扫描成一个图像，请选择单张照片。

• 如果您希望一次扫描多张照片，并且分别保存为单独的图像，请选择多张照片。

注意：在这种情况下，请确保照片之间有至少 1/4 英寸的距离。

扫描开始，并且扫描进度对话框将会出现。

5 保存照片，然后在照片编辑应用程序中打开并进行编辑。

对于 Macintosh（英文版）用户

1 将照片正面朝下放置在扫描仪玻璃上。

2 从 Finder 中的 Applications 文件夹中，启动您要使用的应用程序。

注意：使用支持打印机并允许您处理照片的任意应用程序（例如 Image Capture）。

3 从设备列表中选择您的打印机。

注意：关于查找设备的列表的信息，请检查应用程序随附的文档或者在 Help 菜单的 Search 字段中搜索
Scanning an image。

4 根据您的需要调整扫描设置。

如果适用，请单击 Preview 对话框上的 ? 以获取更多信息。

5 开始扫描作业。

6 保存已扫描的图像，然后使用照片编辑应用程序对其进行编辑。

扫描文档并进行编辑
光学字符识别(OCR)应用程序可供您编辑扫描的文档原件。若要使用该功能，您必须在本地或网络计算机上安
装有 OCR 应用程序，且在您设置扫描时您必须能从应用程序列表中选择 OCR 应用程序。

选择扫描设置时，请选择扫描到安装有 OCR 的本地计算机或网络计算机。

对于 Windows 用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 单击 或开始。

3 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > 扫描 > 文档

扫描开始，并且扫描进度对话框将会出现。

5 扫描完成后，请保存文档。

该文件将转换为可以编辑的格式。

6 用相应的应用程序打开该文档以进行编辑。
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对于 Macintosh（英文版）用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 从 Finder 中的 Applications 文件夹中，启动您要使用的应用程序。

注意：

• 使用支持打印机并允许您处理 OCR 软件的任意应用程序 ABBYY FineReader。

• 如果缺少 OCR 软件，请插入安装软件光盘。使用自定义安装选项重新安装打印机软件，以便您可以
手动选择列出的所有程序包。

3 从设备列表中选择您的打印机。

注意：关于查找设备的列表的信息，请检查应用程序随附的文档或者在 Help 菜单的 Search 字段中搜索
Scanning an image。

4 根据您的需要调整扫描设置。

如果适用，请单击 Preview 对话框上的 ? 以获取更多信息。

5 将 OCR 软件设置为扫描目的地，然后开始扫描作业。

6 如有必要，请选择您要将文件转换为的格式。

7 保存文件。

注意：根据您的设置，系统可以在您能够开始编辑时立即以相应的应用程序打开该文件。

使用打印机软件直接扫描到电子邮件
请确认您已设置了电子邮件设置，然后再继续。如要获取更多的信息，请参阅用户手册中关于电子邮件的部
分。

对于 Windows 用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 单击 或开始。

3 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

4 依次选择：

单击打印机主页 > 选择您的打印机 > 扫描

5 选择用电子邮件发送照片、用电子邮件发送文档或用电子邮件发送 PDF。

注意：如果您的计算机上装有 OCR 应用程序，那么您仅可以选择用电子邮件发送文档。

扫描开始，并且扫描进度对话框将会出现。扫描完成后，将创建新电子邮件信息并自动添加所扫描的文档。

6 撰写电子邮件信息。

注意：如果没有自动打开您的电子邮件程序，那么可以将文档扫描到计算机，然后将其以附件形式通过电子
邮件发送。
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对于 Macintosh（英文版）用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 从 Finder 中的 Applications 文件夹中，启动您要使用的应用程序。

注意：使用任何支持打印机和电子邮件选项的应用程序（例如 Image Capture）。

3 从设备列表中选择您的打印机。

注意：关于查找设备的列表的信息，请检查应用程序随附的文档或者在 Help 菜单的 Search 字段中搜索
Scanning an image。

4 根据您的需要调整扫描设置。

如果适用，请单击 Preview 对话框上的 ? 以获取更多信息。

5 将电子邮件应用程序设置为扫描目的地，然后开始扫描作业。

6 撰写电子邮件信息。

扫描为 PDF

对于 Windows 用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 单击 或开始。

3 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > 扫描 > PDF

扫描开始，并且扫描进度对话框将会出现。

5 将文档保存为 PDF。

对于 Macintosh（英文版）用户

1 将文档原件正面朝上装入自动文档传送器(ADF)内，或者正面朝下放置在扫描仪玻璃上。

2 从 Finder 中的 Applications 文件夹中，启动您要使用的应用程序。

注意：使用支持打印机的任何应用程序。

3 从设备列表中选择您的打印机。

注意：关于查找设备的列表的信息，请检查应用程序随附的文档或者在 Help 菜单的 Search 字段中搜索
Scanning an image。

4 根据您的需要调整扫描设置。

如果适用，请单击 Preview 对话框上的 ? 以获取更多信息。

5 将支持 PDF 格式的应用程序设置为扫描目的地，然后开始扫描作业。

6 将文档保存为 PDF。
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扫描常见问答

我如何提高扫描质量？
• 请确认您的文档原件完好无误。

• 请确认用于接收扫描结果的应用程序是适当的应用程序。例如，如果您要扫描照片并进行编辑，请确认您
选择了照片编辑应用程序接收扫描结果。如果您要扫描文档并编辑其中的文本，请确认您选择了 OCR 应
用程序。

• 使用较高的分辨率。

如何进行黑白扫描？

所有的扫描作业默认都是彩色的。如要以黑白色进行扫描，请按打印机操作面板上的 。

为什么会要求我输入识别码？

识别码是一种安全措施，用于限制扫描的信息只发送到指定的位置，或者防止其他人看到或使用扫描的内容。
如果您要发送扫描结果的网络计算机需要识别码，打印机可能会提示您输入识别码。

如要了解如何为网络计算机指定识别码，请参阅适用于您的操作系统的打印机软件帮助。

取消扫描作业
按打印机操作面板上的  按钮，或者在计算机屏幕上单击“取消”。

扫描 53



电子邮件
您必须首先配置您打印机的网络连接和电子邮件设置，然后才可以发送电子邮件。

设置打印机的电子邮件功能

设置电子邮件功能

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > 设置 > 设置打印机发送邮件

“电子邮件设置向导”将会打开。

4 按照计算机屏幕上的指导进行操作。

对于 Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹 > Printer Settings > Email

2 按照计算机显示屏上的指导进行操作，然后单击 Save Settings。

使用计算机创建电子邮件联系人列表

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 >传真 >编辑联系人列表 >从电话簿中选择

4 在“电话簿”字段中选择电话簿。

您可以选择任何您用于保存电子邮件地址的邮件客户端电话簿。

5 选择您希望添加的联系人，然后单击添加到列表或改变列表导入联系人。

6 单击 OK。

对于 Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Printer Settings。
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3 依次选择：

Contacts 选项卡 > Individuals 选项卡

4 单击 以打开通讯簿。

注意：如要添加联系人，您需要从您的 Macintosh 计算机上的通讯簿中导入联系人。如果联系人不在
Mac 通讯簿中，请先将联系人添加到通讯簿中，然后再导入。

5 在通讯簿中单击您希望添加的联系人，然后将它拖动到 Contacts 列表中。

如要获取更多的信息，请单击帮助或 ? 以查看有关传真软件的帮助信息。

发送电子邮件

扫描仪玻璃

将文档原件正面朝下放置在扫描仪的放置角落。

注意：自动文档传送器 (ADF) 仅在精选打印机型号上可用。

电子邮件提示
• 在发送电子邮件之前，请确认您输入了电子邮件帐号信息并设置了 SMTP 服务器。

• 在发送电子邮件之前，请确认打印机连接在以太网络或无线网络中。

如有必要，请确认网络连接在 Internet 中，以便打印机可以与 SMTP 服务器进行通讯。如果打印机不能连
接到 Internet，请与您的系统支持人员联系。

打印机一次仅支持一种活动的网络连接（以太网或无线网络）。

• 向您的通讯簿中添加联系人。当发送电子邮件时，您可以直接从通讯簿中选择联系人，而无须重复输入他
们的电子邮件地址。

• 请确保将源文档或照片面朝下装载到扫描仪玻璃或放置角落上。

请不要在 ADF 内装入明信片、照片、较小的物体、透明胶片、照片纸或较薄的介质（例如杂志剪辑）。

• 如果可能，请关闭扫描仪顶盖，避免在扫描的图像上留下黑边。

• 要发送电子邮件，请参阅第 51 页“使用打印机软件直接扫描到电子邮件”。

电子邮件 55



取消电子邮件
如要取消电子邮件，请按  按钮。
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网络

在无线网络中安装打印机

无线网络兼容性

您的打印机包含一个 IEEE 802.11n 无线打印服务器。您的打印机可以兼容经过 Wi-Fi 认证的 IEEE 802.11
b/g/n 路由器。

可支持的网络安全性选项

打印机支持三种无线安全性选项：WPA／WPA2、WEP 和无安全性。

WPA2/WPA

WPA（Wi-Fi 保护访问）和 WPA2（Wi-Fi 保护访问 2）可以提供比 WEP 更强的无线网络安全性。WPA2 和
WPA 是类似的安全性类型。WPA2 使用更复杂的加密方法，比 WPA 更安全。WPA2 和 WPA 都使用一系列
字符（称为 WPA 预共享密钥或密码短语）来保护无线网络，避免遭受未经授权的访问。

WPA2 和 WPA 密码必须为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。WPA 密钥中的
ASCII 字符需要区分大小写。

无线网络中的所有设备都必须使用相同的 WPA 密钥。WPA 安全性只能用于使用接入点（无线路由器）和支
持 WPA 的网卡的 Infrastructure 网络。大多数比较新的无线网络设备也可以选择使用 WPA2 安全性。

注意：如果您的网络使用 WPA2 和 WPA 安全性，当提示您选择您的网络所使用的安全性类型时，请选择
WPA 个人。

WEP

WEP（有线等效加密）是最基本和最薄弱的无线安全性。WEP 安全性依靠一系列字符来实现，称为 WEP 密
钥。

无线网络中的所有设备都必须使用相同的 WEP 密钥。WEP 安全性可以用于 Ad hoc 网络和 Infrastructure 网
络。

有效的 WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。

无安全性

我们不推荐您在家用无线网络中根本不使用安全性。不使用安全性意味着您的无线网络范围内的所有人都可以
使用您的网络资源—包括 Internet 访问（如果您的无线网络可以连接到 Internet）。您的无线网络的范围可能
会超出您的住所的墙壁，导致在街道上或者在您的邻居家中可以访问您的网络。
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打印网络设置页

A 网络设置页 列出了您打印机的配置设置，包括打印机的 IP 地址和 MAC 地址。

1 装入普通纸。

2 从打印机控制面板，依次选择：

 >设置图标 > OK  >网络设置 > OK  >网络设置页 > OK

在无线网络中安装打印机所需的信息

如要安装打印机以实现无线打印，您需要知道：

• 您的无线网络的名称，也称为 SSID（服务设置识别码）

• 是否使用了加密措施保护您的网络安全

• 安全密钥（WEP 密钥或 WPA/WPA2 密钥）

如要查找无线网络的 WPA/WPA2 密码，请参阅随同您的接入点一起提供的帮助文档，参阅接入点所对应
的网页，或者向您的系统支持人员咨询。

如果您的接入点使用 WEP 安全性，WEP 密钥应该为：

• 10 个或 26 个十六进制字符

或者

• 5 个或 13 个 ASCII 字符

如果您的接入点使用 WPA 或 WPA2 安全性，WPA/WPA2 密钥应该为：

• 64 个十六进制字符

或者

• 8-63 个 ASCII 字符

注意：

• 十六进制字符包括 A–F、a–f 和 0–9。

• ASCII 字符包括字母、数字和可以在键盘上找到的字符。WPA/WPA2 密码中的 ASCII 字符需要区分大小
写。

如果您的无线网络没有使用安全措施，则您不会有安全密钥。

注意：如果您不知道您的计算机所连接的网络的 SSID，请运行计算机网络适配器的无线应用程序并查找网
络名称。如果您无法找到您的网络的 SSID 或安全信息，请参阅随同接入点一起提供的帮助文档，或者与您
的系统支持人员联系。

在高级无线设置期间您将需要的信息

在高级无线设置期间，Wireless Setup Utility 不为您检测无线网络 SSID。在手动配置无线打印机设置之前，
您必须知道下列信息：
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无线模式

检查您的无线网络类型：

Infrastructure—无线网络上的所有设备通过访问点（无线路由器）相互通信。

Ad‑Hoc—网络设备直接相互通信，而不使用集中的安全性或访问点。Ad hoc 模式可能仅在选定型号或操
作系统中可用。

注意：Infrastructure 是推荐的网络配置，因为它具有更快的传输速度、更好的安全选项以及配置的简易性。

网络名称（SSID）

这是区域内区分一个网络与其他网络的识别名。

通道

自动被默认选定，并且如果网络是在 Infrastructure 模式中配置那么不可更改。

注意：

• Ad hoc 模式可能仅在选定型号或操作系统中可用。

• 如果网络在 Ad hoc 模式中被设置，请选择网络中其他设备正在使用的通道。Ad hoc 网络中的所有设
备必须使用相同的通道相互通信。

• 打印机每次只能在一个无线网络上通信。在 Ad hoc 无线网络中配置打印机可以避免打印机在任何其
他的无线网络（Ad hoc 或 Infrastructure）中工作。

验证

决定您是否有 Infrastructure 或 Ad hoc 设置，然后检查相应的验证类型。

注意：一些验证类型可能仅在选定型号或操作系统中可用。

无线模式 验证类型

Infrastructure • 开放模式

• 共享模式

• WPA Personal

• WPA2‑Personal

• WPA2‑Enterprise

• 802.1X ‑ RADIUS

Ad hoc 开放模式

加密

检查网络上使用的加密方法。

注意：一些验证类型可能仅在选定型号或操作系统中可用。

验证类型 加密方法

开放模式 • 无

• WEP

共享模式 WEP

WPA Personal TKIP

WPA2‑Personal • TKIP

• AES
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验证类型 加密方法

WPA2‑Enterprise • TKIP

• AES

802.1X ‑ RADIUS • 无

• WEP‑DynamicKeys

• WEP‑StaticKeys

• WPA‑TKIP

• WPA‑AES

在无线网络中安装打印机

在无线网络中安装打印机之前，请确认：

• 您的无线网络已设置并且工作正常。

• 您要使用的计算机连接在您希望安装打印机的同一个无线网络中。

对于 Windows 用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

如果 1 分钟之后仍然没有显示安装对话框，请手动运行光盘：

a 单击 ，或单击开始，然后单击运行。

b 在“开始搜索”或“运行”对话框中键入 D:\setup.exe，其中 D是您光盘驱动器或 DVD 驱动器的
盘符。

c 按 Enter 键，或者单击确定。

3 按照计算机屏幕上的指导进行操作。

注意：提示选择连接类型时，请选择无线连接。

对于 Macintosh（英文版）用户

1 关闭所有打开的应用程序。

2 插入安装软件光盘。

如果 1 分钟之后安装对话框仍未出现，请单击计算机桌面上的光盘图标。

3 双击软件安装程序包，然后按照计算机屏幕上的指导进行操作。

注意：提示选择连接类型时，请选择 Wireless connection。

在其他计算机上安装打印机

一旦在无线网络中设置打印机，网络中任一计算机都可通过无线方式访问此打印机。然而，您必须在需要访问
打印机的所有计算机上安装打印机驱动程序。尽管需要在每台计算机上安装设置软件以安装驱动程序，然而您
不必再次配置打印机。
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对于 Windows 用户

1 关闭所有打开的软件应用程序。

2 插入安装软件 CD。

如果 1 分钟之后仍然没有显示安装对话框，请手动运行 CD：

a 单击 ，或单击开始，然后单击运行。

b 在“开始搜索”或“运行”对话框中键入 D:\setup.exe，其中 D是您 CD 驱动器或 DVD 驱动器的
盘符。

c 按输入键，或者单击确定。

3 按照计算机屏幕上的指示在新计算机中安装已配置的打印机。

对于 Macintosh（英文版）用户

1 关闭所有打开的应用程序。

2 插入安装软件 CD。

如果 1 分钟之后安装对话框仍然没有出现，请单击计算机桌面上的 CD 图标。

3 双击软件安装程序包。

4 选择我的打印机已经设置过。我要将其安装到新的计算机。

5 单击 Continue，然后遵循计算机屏幕上的指示在新计算机上安装配置的打印机。

使用网络指示灯确定打印机状态

Wi‑Fi 或以太网指示灯显示打印机的网络状态。

注意：

• 网络指示灯位于打印机操作面板上。打印机可能有以太网和/或无线连接指示灯，这取决于您的打印机型
号。要查看打印机是否具备以太网或无线网络功能，请参考快速参考手册，或与您的系统支持人员联
系。

• 打印机一次支持一个本地连接(USB)和一个网络连接（以太网或无线网络）。无法同时使用以太网和无线
网络。

指示
灯 灯

打印机 状态

关 • 打印机的电源已关闭或者正在开机。

• 打印机没有连接在以太网或无线网络中并且处于睡眠模式。

• 打印机没有经过配置，无法在以太网或无线网络中使用。

• 打印机已经配置了 Ad hoc 连接，但是现在没有和其他的 Ad hoc 设备进行通讯。

绿灯闪
烁

• 打印机已配置了以太网络，但是其无法与网络建立连接。

• 打印机不在接入点（无线路由器）范围内。

• 打印机正在尝试与接入点进行通讯，但是接入点可能已关闭电源或者未正常工作。

• 接入点关闭了电源并重新打开，打印机正在尝试建立网络连接。

• 打印机的无线设置可能不再有效。

检查打印机使用的 SSID、WEP 密钥或 WPA/WPA2 预共享密钥/密码、安全类型和 IP 地址是否仍然正确。
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指示
灯 灯

打印机 状态

绿灯长
亮

• 打印机已经连接到以太网或无线网络，并且可以使用。

• 打印机已经通过 Ad hoc 连接到了您的计算机或移动设备。

特殊的无线安装指导

以下的指导适用于北美洲以外且使用无线宽带 box 的用户。以下是一些 box 的例子：LiveBox、AliceBox、
N9UF Box、FreeBox 和 Club Internet。

在您开始安装之前

• 请确认您的 box 具备无线功能，并且可以在无线网络中使用。有关配置 box 以便在无线网络中使用的更多
帮助信息，请参阅随同您的 box 一起提供的说明文档。

• 请确认您的 box 的电源已打开，并且您的计算机已打开并连接在您的无线网络中。

向您的无线网络中添加打印机

1 使用提供的安装指导在无线网络中安装您的打印机。

当提示您选择网络时，请停止操作。

2 如果您的 box 后面有一个关联／注册按钮，请在选择网络之前按此按钮。

注意：按关联／注册按钮之后，您有 5 分钟时间完成打印机的安装。

3 返回到计算机屏幕。

从显示的无线网络列表中选择您的网络，然后单击“继续”。

如果您的无线网络没有显示在列表中：

a 连接到其他的无线网络。

Windows 用户

单击“未列出的网络”。

Macintosh（英文版）用户

从列表中选择 Other Wireless Network，然后单击 Continue。

b 输入有关您的无线网络的详细资料。

注意：您可以从 box 的底部、随同 box 一起提供的帮助文档或者 box 的网页获得 WEP、WPA 或
WPA2 密钥。如果您已经改变了您的无线网络的密钥，请使用您创建的密钥。

4 按照计算机屏幕上的指导完成安装。

指定静态 IP 地址

在大多数的无线网络中，打印机将会通过 DHCP 自动分配一个 IP 地址。

1 完成无线设置，允许打印机从网络中的 DHCP 服务器接收一个 DHCP 地址。

2 打印一张网络设置页，查看当前为打印机分配的 IP 地址。

3 打开网络浏览器，然后在地址栏中输入打印机的 IP 地址。按 Enter 键。

注意：如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开打印机网页。
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4 单击“配置 > TCP/IP > 设置静态 IP 地址”。

5 在“地址”字段中输入您希望为打印机指定的 IP 地址，然后单击“提交”。

如要确认，请在网页浏览器的地址栏中输入静态 IP 地址，然后按 Enter 键。

如要获取更多的信息，请与您的系统支持人员联系。

安装后更改无线设置

如要更改打印机的无线设置（例如配置的网络和安全密钥），请进行以下操作：

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > 设置选项卡 > Wireless Setup Utility

4 按照计算机屏幕上的指导进行操作。

对于 Macintosh（英文版）用户

1 从 Finder 的 Applications 文件夹或 Finder 桌面上双击打印机文件夹。

2 双击 Wireless Setup Assistant。

3 按照计算机屏幕上的指导进行操作。

高级无线设置

创建 Ad hoc 无线网络

如果您满足以下条件，您可以安装一个 Ad hoc 网络：

• 没有无线接入点或无线路由器。

• 没有无线网络（但您的计算机带有无线网络适配器）。

• 希望在打印机和带有无线网络适配器的计算机之间安装一个独立的网络。

注意：

• 开始之前，请确保无线网络适配器与计算机连接正确并且工作正常。

• 我们推荐您使用接入点（无线路由器）安装您的无线网络。安装的网络称为 Infrastructure 网络。

• 如果您的计算机有 My WiFi 或 Wi‑Fi Direct，您可以创建到您无线打印机的直接连接。如需更多信息，请
参阅计算机随附的文档。

• 打印机一次只能在一个无线网络中进行通讯。在 Ad hoc 无线网络中配置打印机可以避免打印机在其他的
无线网络（Ad hoc 或 Infrastructure）中工作。
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Windows Vista 或更高版本：

1 单击  > 控制面板 > 网络和 Internet  >网络和共享中心.

2 单击设置连接或网络 > 设置无线临时（计算机到计算机）网络 >下一步。

3 按照有关设置无线 Ad hoc 网络的指导进行操作。

在安装过程中：

a 为计算机和您的打印机之间的网络创建一个网络名称或 SSID。

b 记录下您的网络名称。请确认您准确记录了所有内容，包括大写字母。

c 从“安全类型”列表中选择 WEP 或 WPA2 - 个人，然后创建一个 WPA 密钥或 WPA/WPA2 预共享密
钥/密码。

WEP 密钥必须为：

• 10 个或 26 个十六进制字符

或者

• 5 个或 13 个 ASCII 字符

WPA/WPA2 预共享密钥/密码必须是：

• 64 个十六进制字符

或者

• 8-63 个 ASCII 字符

注意：

• 十六进制字符包括 A–F、a–f 和 0–9。
• ASCII 字符包括字母、数字和可以在键盘上找到的符号。WPA/WPA2 预共享密钥/密码中的 ASCII
字符需要区分大小写。

d 记录下您的网络密码。请确认您准确记录了所有内容，包括大写字母。

Windows Vista 将会为您启用 Ad hoc 网络。它将显示在“可用网络”下的“连接网络”对话框中，表示计
算机配置了 ad hoc 网络。

4 关闭 Windows 控制面板和所有其他的窗口。

5 插入安装软件光盘，然后按照计算机屏幕上的指导进行无线安装。

注意：请不要连接安装或网络电缆，直到安装软件提示您这样做。

6 当显示出可用网络后，请提供您创建的网络名称和安全信息。安装程序将会配置打印机，以便连接您的计
算机使用。

7 将您的网络名称和安全信息保存在安全的地方，以备将来使用。

注意：Windows Vista 计算机重新启动之后，您可能需要重新将它连接到 Ad hoc 网络中。

在 Windows XP 中

1 单击开始 >控制面板 >网络和 Internet 连接 >网络连接。

2 右键单击“无线网络连接”图标。

3 如果弹出菜单中显示启用，请单击。

注意：如果弹出菜单中显示“停用”，说明您的无线连接已经启用。

4 右键单击“无线网络连接”图标。
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5 单击属性 >无线网络选项卡。

注意：如果未显示“无线网络”选项卡，说明您的计算机使用第三方的软件来控制您的无线设置。您必
须使用该软件设置 Ad hoc 无线网络。更多信息，请参阅第三方软件文档。

6 选中用 Windows 来配置我的无线网络设置复选框。

7 在“首选网络”下面，删除所有现有的网络。

选择网络，然后单击移除以从列表中删除网络。

8 单击添加创建一个 Ad hoc 网络。

9 在“服务名(SSID)”框中输入您要用的无线网络名称。

10 记录下您输入的名称，当您进行无线设置的时候可能会需要此信息。请确认您准确记录了所有内容，包括
大写字母。

11 如果列表中显示“网络身份验证”，请选择打开。

12 从“数据加密”列表中选择 WEP。

13 如有必要，请取消选中“自动为我提供此密钥”复选框。

14 在“网络密钥”框中输入 WEP 密钥。

15 记录下您输入的 WEP 密钥，当您进行无线设置的时候可能会需要此信息。请确认您准确记录了所有内容，
包括大写字母。

16 在“确认网络密钥”框中输入相同的 WEP 密钥。

17 选中这是一个计算机到计算机(ad hoc)网络；没有使用无线访问点。

18 单击两次确定关闭打开的窗口。

19 您的计算机可能需要几分钟来识别新的设置。如要检查您的网络的状态：

a 右键单击无线网络连接图标。

b 选择查看可用的无线网络。

• 如果网络已列出，但是计算机没有连接，请选择 Ad hoc 网络，然后单击连接。

• 如果未显示网络，请等待一会儿，然后单击刷新网络列表。

20 插入安装软件 CD，然后按照计算机屏幕上的指导进行无线安装。

注意：请勿连接安装或网络电缆，直到安装软件提示您这样做。

21 当显示出可用网络后，请提供您创建的网络名称和安全信息。安装程序将会配置打印机，以便连接您的计
算机使用。

22 将您的网络名称和安全信息保存在安全的地方，以备将来使用。

对于 Macintosh（英文版）用户

1 读取 Airport 设置：

Mac OS X version 10.5 或更高版本

从 Apple 菜单中依次选择：

System Preferences > Network > AirPort
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在 Mac OS X version 10.4 或更早版本中

从 Finder 中依次选择：

Applications > Internet Connect > AirPort

2 从 Network Name 或 Network 菜单中单击 Create Network。

3 为您的 Ad hoc 网络创建一个名称，然后单击 OK。

注意：将您的网络名称和密码保存在安全的地方，以备将来使用。

向现有的 Ad hoc 无线网络中添加打印机

注意：打印机一次只能在一个无线网络中进行通讯。在 Ad hoc 无线网络中配置打印机会将打印机从所有其
他配置过的无线网络（Ad hoc 或 Infrastructure）中删除。

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > 设置选项卡 > Wireless Setup Utility

4 按照计算机屏幕上的指导进行操作。

注意：Windows Vista 计算机重新启动之后，您可能需要将其重新连接到 Ad hoc 网络中。

对于 Macintosh（英文版）用户

1 从 Finder 的 Applications 文件夹或 Finder 桌面上双击打印机文件夹。

2 双击 Wireless Setup Assistant。

3 按照计算机屏幕上的指导进行操作。

使用 WPS 配置打印机以便无线使用（仅限于 Windows）
使用 Wi‑Fi Protected Setup(WPS)可以轻松地将计算机或打印机添加到您的无线网络中，因为它可以自动为您
检测并配置 SSID 和 WPA 密钥。

1 请确认您的接入点（无线路由器）支持 WPS。

2 插入安装软件光盘，然后按照计算机屏幕上的指导进行操作。

注意：

• 如果您要使用 WPS 识别码方式添加您的打印机，当要求您输入您的识别码时，请确认输入所有的 8 位
数字。

• 如要使用 WPS 配置打印机以便无线使用，您的无线网络中的所有设备都必须支持 WPS。如果您的网络
中有不支持 WPS 的设备，则您必须在出现提示时输入 SSID 和安全性信息。
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手动配置 Wi‑Fi Protected Setup
注意：请确认您的接入点（无线路由器）是 Wi‑Fi Protected Setup (WPS)认证的。如需更多信息，请参阅用
户手册。

如果您的打印机或设备还没有配置无线连接而您希望使用 WPS 进行配置，那么请按无线路由器上的 WPS 按
钮。等待打印机操作面板上显示信息以开始 WPS 配置。显示消息之前可能会有短暂的延迟。如果 30 秒钟之
后什么也没有发生，请按照以下的步骤进行操作：

使用“按钮配置(PBC)”方法

1 从打印机控制面板，依次选择：

 >设置图标 > OK  >网络设置 > OK  >无线 802.11b/g/n > OK  >网络连接设置 > OK  >无线 > OK  >Wi‑Fi
Protected Setup > OK  >WPS PBC 模式 > OK

2 按照打印机显示屏上的指导进行操作。

使用“个人识别码(PIN)”方法

1 从打印机控制面板，依次选择：

 >设置图标 > OK  >网络设置 > OK  >无线 802.11b/g/n > OK  >网络连接设置 > OK  >无线 > OK  >Wi‑Fi
Protected Setup > OK  >WPS PIN 模式 > OK

2 按照打印机显示屏上的指导进行操作。

在 USB、以太网和无线连接之间转换（仅限于 Windows）
您可以根据您的需要改变访问您的打印机的方法。以下步骤假定您已经按照一种连接类型配置了您的打印机，
并且已经在计算机上安装了打印机驱动程序。如果您在配置过程中遇到了困难，请参阅与该连接类型相关的问
题解答主题。

注意：打印机一次支持一个可用本地连接(USB)和一个可用网络连接（以太网或无线网络）。无法将打印机
同时连接到以太网和无线网络。

无线使用打印机

根据您当前对打印机的访问方式来选择相应的连接类型：

如果打印机当前为本地安装（使用 USB 连接）

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > 设置选项卡 > Wireless Setup Utility

4 按照计算机屏幕上的指导进行操作。

注意：在无线配置过程中，您不需要断开连接打印机和计算机的 USB 电缆。
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如果打印机当前为以太网设置

1 从打印机上断开以太网电缆。

2 将打印机放置在您希望用于配置打印机以实现无线访问的计算机附近。

注意：您需要使用一根 USB 电缆将打印机连接在计算机上。请确认打印机距离计算机足够近，以便您的
USB 电缆两端都可以连接。

3 单击 或开始。

4 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

5 依次选择：

打印机主页 > 选择您的打印机 > 设置选项卡 > Wireless Setup Utility

6 按照计算机屏幕上的指导进行操作。

在本地使用打印机(USB)

根据您当前对打印机的访问方式来选择相应的连接类型：

如果打印机当前为以太网设置

1 使用 USB 电缆连接计算机和打印机。

2 稍等片刻，等待 Windows 找到驱动程序并完成安装打印机。

3 选择 USB 打印机。请参阅第69 页“选择打印机”。

如果打印机当前为无线安装

1 使用 USB 电缆连接计算机和打印机。

2 稍等片刻，等待 Windows 找到驱动程序并完成安装打印机。

3 选择 USB 打印机。请参阅第69 页“选择打印机”。

注意：您可以通过以太网或无线连接继续使用打印机。

通过以太网络使用打印机

根据您当前对打印机的访问方式来选择相应的连接类型：

如果打印机当前为无线安装

1 将以太网电缆的一端连接在打印机上，另一端连接在转换器或墙壁电话线插座的可用插口上。

2 稍等片刻，等待以太网络适配器可用并且从网络获取一个 IP 地址。

3 选择网络打印机。请参阅第69 页“选择打印机”。

注意：当打印机连接到以太网络中以后，无线适配器将会断开。

如果打印机当前为本地安装（使用 USB 连接）

1 将以太网电缆的一端连接在打印机上，另一端连接在转换器或墙壁电话线插座的可用插口上。

2 在您希望用于配置打印机的计算机内插入安装软件光盘。
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3 按照计算机屏幕上的指导在以太网络中配置打印机。

4 选择网络打印机。请参阅第69 页“选择打印机”。

注意：您需要一根 USB 电缆来完成配置。

选择打印机

1 打开打印机文件夹。

a 单击 或开始。

b 在“开始搜索”或“运行”框中输入控制打印机。

c 按 Enter 键，或者单击确定。

2 右键单击您希望使用的打印机（网络或 USB）。

3 从菜单中选择设为默认打印机。

4 关闭“打印机”或“打印机和传真”窗口。

在 USB、以太网和无线连接之间转换（仅限于 Macintosh 英文版）

您可以根据您的需要改变访问您的打印机的方法。以下的步骤假定您已经按照一种连接类型配置了您的打印
机，并且计算机上安装了打印机驱动程序。如果您在配置过程中遇到了困难，请参阅与该连接类型相关的问题
解答主题。

注意：打印机一次支持一个可用本地连接(USB)和一个可用网络连接（以太网或无线网络）。不可能同时将
打印机连接到以太网和无线网络。

无线使用打印机

根据您当前如何访问您的打印机选择相应的连接类型：

如果打印机当前为本地安装（使用 USB 连接）

1 关闭所有打开的应用程序。

2 插入安装软件光盘。

如果 1 分钟之后安装对话框仍未出现，请单击计算机桌面上的光盘图标。

3 双击 Lexmark Extras > Lexmark Setup Assistant。

4 按照计算机屏幕上的指导进行操作。

注意：在无线配置过程中，您不需要断开连接打印机和计算机的 USB 电缆。

如果打印机当前为以太网设置

1 从打印机上断开以太网电缆。

2 将打印机放置在您希望用于配置打印机并实现无线访问的计算机附近。

注意：您需要使用一根 USB 电缆将打印机连接在计算机上。请确认打印机距离计算机足够近，以便您的
USB 电缆可以连接两端。

3 关闭所有打开的应用程序。
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4 插入安装软件光盘。

如果 1 分钟之后安装对话框仍未出现，请单击计算机桌面上的光盘图标。

5 双击 Lexmark Extras > Lexmark Setup Assistant。

6 按照计算机屏幕上的指导进行操作。

7 另一个打印队列将会创建。如果您不希望切换回通过以太网连接访问打印机，请删除以太网队列。

在本地使用打印机(USB)

根据您当前如何访问您的打印机选择相应的连接类型：

如果打印机当前为以太网设置

1 将 USB 电缆上正方形的一端牢固地插入打印机后面的 USB 接口中。

2 将 USB 电缆上长方形的一端牢固地插入计算机的 USB 接口中。

3 添加打印机。请参阅第71 页“添加打印机”。

4 另一个打印队列将会创建。如果您不希望切换回通过以太网连接访问打印机，请删除以太网队列。

如果打印机当前为无线安装

1 使用 USB 电缆连接计算机和打印机。

2 添加打印机。请参阅第71 页“添加打印机”。

3 另一个打印队列将会创建。如果您不希望改回通过无线连接访问打印机，请删除无线队列。

通过以太网络使用打印机

根据您当前如何访问您的打印机选择相应的连接类型：

如果打印机当前为无线安装

1 将以太网电缆的一端连接在打印机上，另一端连接在转换器或墙壁插座的可用插口上。

2 稍等片刻，等待以太网络适配器可用并且从网络获取一个 IP 地址。

3 添加打印机。请参阅第71 页“添加打印机”。

4 另一个打印队列将会创建。如果您不希望改回通过无线网络访问打印机，请删除无线队列。

如果打印机当前为本地安装（使用 USB 连接）

1 将以太网电缆的一端连接在打印机上，另一端连接在转换器或墙壁插座的可用插口上。

2 在您希望用于配置打印机的计算机内插入安装软件光盘。

3 按照计算机屏幕上的指导进行操作。

注意：如要完成配置，您需要一根 USB 电缆。
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添加打印机

Mac OS X V10.5 或更高版本

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax

2 单击+。

3 单击 Default 或 Default Browser 选项卡，然后选项您的打印机。

4 单击 Add。

Mac OS X V10.4 或更早的版本

1 在 Finder 桌面上单击 Utilities。

2 双击 Printer Setup Utility 或 Print Center。

3 在 Printer List 对话框中选择您希望使用的打印机，然后单击 Add。

4 从 Printer Browser 中选择您的打印机，然后单击 Add。

在 Windows 环境下共享打印机

1 准备好要共享打印机的计算机：

a 在所有需要进行打印的计算机上启用“文件和打印机共享”，使得这些计算机可以出现在“网上邻居”
中。请参阅 Windows 文档获取有关启用“文件和打印机共享”的指导。

b 在所有需要进行打印的计算机上安装打印机软件。

2 标识打印机：

a 在与打印机相连的计算机上，打开打印机文件夹：

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入控制打印机。

3 按 Enter 键，或者单击确定。

b 右键单击您的打印机名称。

c 单击共享或打印机属性。

d 在“共享”选项卡中选择共享这台打印机或共享为。

e 输入一个不同于其他打印机的名称，然后单击确定。

3 在远程计算机上定位打印机：

注意：远程计算机是指没有直接连接打印机的计算机。

a 打开打印机文件夹：

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入控制打印机。

3 按 Enter 键，或者单击确定。

b 右键单击您的打印机名称。

c 单击属性或打印机属性。

d 单击端口 >添加端口 >本地端口 >新端口。
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e 输入符合通用命名标准(UNC)的端口名称，包括服务器名称和指定的打印机名称第 71 页中的步骤 2。
端口名称应该为以下格式：\\服务器\打印机。

f 单击确定。

g 在“打印机端口”对话框中单击关闭。

h 请确认在“端口”选项卡中选中了新的端口，然后单击应用。

i 单击确定。

在 Macintosh（英文版）环境下共享打印机

1 在 Finder 桌面上单击 Help > Mac Help。

2 在 Search 字段中输入 sharing the printer on a network，然后按 return 键。

3 从以下选项中只选择一项：

• 与 Mac OS X 用户共享您的打印机 — 允许网络中其他使用 Mac OS X version 10.4 或更高版本的
Macintosh 计算机使用连接在您的 Macintosh 计算机上的打印机。

• 与 Windows 用户共享您的打印机 — 允许网络中的 Windows 计算机使用连接在您的 Macintosh 计算
机上的打印机。

4 按照计算机屏幕上的指导进行操作。

注意：Windows 用户可以参阅 Windows 帮助文档获取有关添加网络打印机并连接到 Macintosh 计算机的信
息。

配置安全性

简单的无线网络需要 WEP 密钥或 WPA/WPA2 密钥，或者不需要任何安全性。更高级的无线网络安全性可能
要求一个或多个证书和验证服务器。如果网络要求一个您没有的证书，请填写 Wireless Setup Utility 内提供的
证书申请表并按照您的组织流程请求网络访问的证书。

以下是无线网络安全性的支持类型及其要求的列表。

WEP
• WEP 密钥（最多可能要求四个密钥）

• 默认的 WEP 传输密钥（如果多于一个 WEP 密钥被配置，这将指定使用哪一个）

WPA Personal、WPA2‑Personal 或 WPA2‑Enterprise
• 预共享密钥

• 加密（AES 或 TKIP）

EAP‑MD5、MSCHAPv2 或 LEAP
• RADIUS 用户名

• RADIUS 密码

PEAP
• RADIUS 用户名

• RADIUS 密码

• CA 证书
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EAP‑TLS
• RADIUS 用户名

• RADIUS 密码

• CA 证书

• 签名证书

EAP‑TTLS
• 适当的内部验证

• RADIUS 用户名

• RADIUS 密码

• CA 证书

配置 802.1X 验证

您必须完成的信息取决于您选择的 802.1X 安全机制。其中一些要求用户名、密码和/或证书。如果您的网络包
含多个使用不同验证模式的访问点，那么您可以选择并配置多个验证机制。

1 从“配置 802.1X 验证”对话，键入验证服务器的用户名和密码。

2 确认密码，然后检查选定的验证机制。

如果您已经选择 执行

EAP‑MD5、LEAP 或
MSCHAPv2

继续下一步。

PEAP 或 EAP‑TTLS 单击安装 CA 证书，然后键入到 CA 证书的路径，或者单击浏览来找到证书文件。

EAP‑TLS a 单击安装签名证书，然后键入到签名证书的路径，或者单击浏览来找到证书文件。

b 单击安装 CA 证书，然后键入到 CA 证书的路径，或者单击浏览来找到证书文件。

3 单击确定，然后按照计算机屏幕上的指导进行操作。

网络常见问答

什么是 Wi‑Fi Protected Setup？
Wi‑Fi Protected Setup(WPS)是一种简单且安全的配置，可以帮助您建立无线家用网络和启用网络安全性，不
需要提前了解有关 Wi‑Fi 技术的知识。您不再需要为网络设备配置网络名称(SSID)和 WEP 或 WPA 密钥。

注意： WPS 只支持通过接入点（无线路由器）进行通讯的网络。

打印机支持以下方法连接到无线网络：

• 个人识别码(PIN) — 将打印机上的识别码输入到接入点的无线设置中。

• 按钮配置(PBC) — 在指定的一段时间内分别按打印机和接入点上的按钮。
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查找以下的识别标记可以检查您的接入点是否兼容 WPS：

您可以在您的接入点的侧面、后面或顶部找到这些 WPS 徽标。

如要获取更多有关读取无线设置和确定您的无线接入点的 WPS 兼容性的信息，请参阅随同接入点一起提供的
帮助文档，或者与您的系统支持人员联系。

哪里可以找到我的 WEP 密钥或 WPA/WPA2 密钥？
• 与您的系统支持人员联系。

– 安装您的网络的人通常保存着 WEP 密钥或 WPA/WPA2 密钥。

– 如果您的无线网络是由您的 Internet 服务供应商(ISP)安装的，您可以从他们提供的文档中查找相关的
信息。

• 请参阅随同您的接入点（无线路由器）一起提供的帮助文档。

如果您的接入点使用默认设置，您可以在帮助文档中找到相关的信息。

• 在接入点上查看安全性设置。

1 打开 Web 浏览器，然后在地址栏中输入接入点的 IP 地址。按 Enter 键。

注意：

– 如要获取接入点的 IP 地址，请参阅随同接入点一起提供的帮助文档，或者与您的系统支持人员联
系。

– 如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开网页。

2 当出现提示时，请输入接入点的用户名和密码。

注意：WEP 密钥或 WPA/WPA2 密钥与接入点的密码不同。密码可以允许您访问接入点设置。WEP
密钥或 WPA/WPA2 密钥可以允许打印机和计算机加入到您的无线网络中。

3 查找 WEP 密钥或 WPA/WPA2 密钥。

什么是 SSID？

服务集标识符(SSID)是分配给无线网络的名称。网络中的所有设备必须了解无线网络的服务集标识符(SSID),
否则无法互相通信。通常，无线网络会群发服务集标识符(SSID)，以便区域中的无线设备与其进行连接。有
时，为安全起见，不会群发服务集标识符(SSID)。

如果您的无线网络没有群发服务集标识符(SSID)，那么它就无法被自动识别，从而不会在可用无线网络列表中
出现。这种情况下，您必须手动输入网络信息。

服务集标识符(SSID)最多可包含 32 个字母数字字符。字母数字字符是字母字符（字母 A 到 Z)和数字字符（数
字 0 到 9）的组合。
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哪里可以找到我的 SSID？
• 查看接入点（无线路由器）的设置。

大多数接入点带有内置的网络服务器，可以使用网络浏览器访问。

• 检查您的计算机是否为您的无线网络适配器安装了相应的程序。

很多网络适配器提供了软件应用程序，可以允许您查看您的计算机的无线设置，包括您的 SSID。

如果使用这些方法不能找到您的 SSID，请与您的系统支持人员联系。

什么是网络？

网络是指一组通过电缆或无线连接在一起并互相通讯的设备，例如计算机、打印机、以太网集线器、接入点和
路由器。一个网络可以是有线的、无线的、或者同时包含有线和无线设备。

如何找到我的网络所使用的安全类型？
• 与您的系统支持人员联系。

为您安装网络的人通常保存着您的无线信息。

• 请参阅随同您的接入点（无线路由器）一起提供的帮助文档。

• 检查用于访问您的无线网络的密码所用的字符。

如果你没有使用密码，请选择无或无安全性。

字符 安全类型

10 个或 26 个十六进制字符

或者

5 个或 13 个 ASCII 字符

WEP

64 个十六进制字符

或者

8-63 个 ASCII 字符

WPA 或 WPA2

注意：

– 十六进制字符包括 A–F、a–f 和 0–9。

– ASCII 字符包括字母、数字和可以在键盘上找到的符号。WPA/WPA2 密钥中的 ASCII 字符需要区分
大小写。

• 在接入点上查看安全性设置。

1 打开网页浏览器。在地址字段中输入接入点的 IP 地址，然后按 Enter 键。

注意：

– 如要获取接入点的 IP 地址，请参阅随同接入点一起提供的帮助文档，或者与您的系统支持人员联
系。

– 如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开网页。

2 当出现提示时，请输入接入点的用户名和密码。

注意：WEP 密钥或 WPA/WPA2 密钥与接入点的密码不同。密码可以允许您访问接入点设置。WEP
密钥或 WPA/WPA2 密钥可以允许打印机和计算机加入到您的无线网络中。

3 查找 WEP 密钥或 WPA/WPA2 密钥。
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家用网络如何配置？

台式电脑、便携式笔记本电脑和打印机如要在网络中互相通讯，它们必须连接电缆和／或内置或安装无线网络
适配器。

您可以使用多种不同的方法安装网络。以下是四种普通范例。

注意：下面图中的打印机代表内置了内部打印服务器的打印机，可以在网络中进行通讯。

无线网络范例

方法 1：网络中同时包含有线和无线连接，可以连接到 Internet
• 所有计算机和打印机都通过具有以太网和无线功能的路由器连接在网络中。

• 一些计算机和打印机通过无线连接在路由器上，其他计算机和打印机通过有线连接。

• 网络通过 DSL 或电缆调制解调器连接到 Internet。

Internet

方法 2：无线网络，可以连接到 Internet
• 所有计算机和打印机都通过无线接入点或无线路由器连接在网络中。

• 无线接入点通过 DSL 或电缆调制解调器将网络连接到 Internet。

Internet
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方法 3：无线网络，不可以连接到 Internet
• 计算机和打印机通过无线接入点连接在网络中。

• 网络不能连接到 Internet。

方法 4：计算机通过无线连接到打印机，不可以连接到 Internet
• 计算机直接连接到打印机，没有通过无线路由器。

• 这种配置方法称作 Ad hoc 网络。

• 网络不能连接到 Internet。

注意：大多数计算机一次只能连接到一个无线网络。如果您通过无线连接访问 Internet，当您连接到 Ad hoc
网络时，您将无法访问 Internet。

什么是 USB 电缆？

通用串行总线(USB)电缆主要用于将 USB 设备连接到主机。普通主机包括计算机和视频游戏控制台。通过 USB
端口和电缆，可以连接计算机外围设备，例如鼠标、键盘、数码照相机、个人媒体播放器、Flash 驱动器和外
部硬盘。对于大部分的外部设备来说，USB 已经成为了标准的连接方式。

为什么要使用 USB 电缆？

通过无线网络安装打印机的时候，打印机需要暂时使用 USB 电缆连接到计算机。这个临时的连接用于建立打
印机的无线设置。

我如何连接 USB 电缆？

将 USB 电缆连接到计算机上的 USB 端口和打印机背面的正方形插口。该连接允许您配置打印机进行网络或
本地（USB）安装。
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计算机和打印机上的 USB 端口都带有 标记。

注意：出现提示之前请不要连接 USB 电缆。

1 如果打印机后面的 USB 端口粘有胶带，请将其撕掉。

2 将 USB 电缆上正方形的一端牢固地插入打印机后面的 USB 接口中。
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3 将 USB 电缆上长方形的一端牢固地插入计算机的 USB 接口中。

4 按照计算机屏幕上的指导进行操作。

Infrastructure 和 Ad hoc 网络之间有什么区别？

无线网络可以按照以下两种模式运行：Infrastructure 模式或 Ad hoc 模式

在 Infrastructure 模式下，无线网络中的所有设备都通过接入点（无线路由器）互相通讯。

在 Ad hoc 模式下，带有无线网络适配器的计算机和带有无线打印服务器的打印机直接进行通讯。

Infrastructure Ad hoc

特征

通讯 通过接入点 直接在设备之间

安全性 更多的安全选项 WEP 或无安全性

范围 取决于接入点的范围和数量 受限于网络中单个设备的范围

速度 通常较快 通常较慢

所有设备的需求

每个设备都有唯一的 IP 地址 是 是

模式设置为 Infrastructure 模式 Ad hoc 模式

相同的 SSID 是，包括接入点 是

相同的频道 是，包括接入点 是

我们推荐您使用安装软件光盘按照 Infrastructure 模式安装网络。Infrastructure 模式可以提供：

• 网络安全性较高

• 可靠性较高

• 性能较快

• 安装较简易

查找信号强度

信号强度显示计算机或打印机接收无线网络信号的能力有多强。信号质量差会影响配置过程中的连接。
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检查计算机连接

1 请从计算机系统托盘单击管理无线网络适配器的软件的相应无线图标。

2 检查信号质量。

检查打印机连接

• 从打印机打印网络设置页。

在“无线”部分查找质量。

• 从打印机操作面板查看信号强度。

依次选择：

 > 设置 > OK  > 网络设置 > OK  > 无线 802.11 b/g/n > OK  > 网络连接设置 > OK  > 无线 > OK  > 查看信号质量 >
OK

要提高信号质量，请移走干扰源或将无线设备移到离接入点（无线路由器）更近的地方。

我能够如何改善无线信号强度？

无线打印机无法在网络上通信的一个常见原因是无线信号质量很差。如果信号太弱、太失真或被物体阻挡，它
将不能在访问点和打印机之间传递信息。如需确定打印机是否从访问点接收到强信号，请打印网络设置页。
“质量”字段指出打印机正在接收的无线信号的相对强度。但是，可能会有间歇性的信号强度衰减，并且虽然
信号质量显示为高，但它可能在某些情况下衰减。

如果您认为访问点（无线路由器）和打印机之间的信号强度有问题，请尝试下列办法中的一个或多个：

注意：

• 下面的解决办法适用于 Infrastructure 网络。如果您使用 Ad hoc 网络，请在解决办法建议调整访问点时
调整计算机。

• Ad hoc 网络的范围比 Infrastructure 网络小得多。如果打印机和计算机之间的通信有问题，请尝试移动
打印机使之更靠近计算机。

移动打印机使之更靠近访问点

如果打印机离访问点太远，它将不能与网络上的其他设备通信。对于大多数室内无线网络，访问点和打印机
之间的最大距离大约为 100 英尺（30 米）。根据网络布局和访问点的限制，此距离可以更长或更短。

移除访问点和打印机之间的障碍物

来自访问点的无线信号将通过大多数物体。大部分墙壁、地板、家具和其他物体将不会阻碍无线信号。但
是，有些材料密度太大，无法让信号通过，如包含金属和混凝土的物体。布置打印机和访问点，使信号不会
被此类物体阻碍。

移除干扰源

其他类型的无线电频率可能会导致网络上的无线信号的问题，造成似乎来来回回的打印问题。

• 关闭可能的干扰来源。

• 当通过无线网络打印时，请避免使用微波炉、无绳电话（但除便携式电话）、婴儿监视器，几乎所有的
厨房设备，无线监视装置或含有电机的装置。

• 如果有另一个无线网络在附近运转，请更改访问点上的无线通道。

• 请勿将访问点放在打印机或其他电子设备上。此类设备也会干扰无线信号。
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布置网络以减少信号吸收

即使无线信号能够通过物体，它也会稍有减弱。如果它通过太多物体，它会显著减弱。当无线信号通过物体
时，所有物体都会吸收部分无线信号，并且某些类型的物体吸收足够多而导致通信问题。将访问点尽可能放
在室内高点，以避免信号吸收。

我如何确认我的计算机和打印机连接在同一个无线网络中？

如果打印机和计算机不在同一个无线网络中，您将不能进行无线打印。如果计算机已经连接在无线网络中，打
印机的 SSID 必须与计算机的 SSID 一致。

Windows 用户

1 获取计算机所连接的网络的 SSID：

a 在您的网页浏览器的地址栏中输入您的接入点（无线路由器）的 IP 地址。

如果您不知道接入点的 IP 地址：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击“确定”。

4 输入 ipconfig，然后按 Enter 键。查看“无线网络连接”区域：

• Default Gateway（默认网关）项目通常即为接入点。

• IP 地址由 4 组数字组成，用小数点分开，例如 192.168.2.134。

b 当出现提示时，请输入您的用户名和密码。

c 单击“确定”。

d 在“无线设置”区域中查找 SSID。

e 记录下 SSID。

注意：请确认您准确地记录了所有的内容，包括大写字母。

2 获取打印机所连接的网络的 SSID：

a 从打印机打印一张网络设置页。

b 在“无线”区域中查找 SSID。

3 比较计算机和打印机的 SSID。

如果 SSID 相同，说明计算机和打印机连接在同一个无线网络中。

如果 SSID 不相同，请重新运行无线设置应用程序，在计算机所使用的无线网络中安装打印机。

使用 AirPort 基站的 Macintosh（英文版）用户

Mac OS X version 10.5 或更高的版本：

1 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

计算机所连接的网络的 SSID 将会显示在 Network Name 菜单中。

2 记录下 SSID。
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Mac OS X version 10.4 或更早的版本：

1 从 Finder 中依次选择：

Applications > Internet Connect > AirPort

计算机所连接的网络的 SSID 将会显示在 Network 菜单中。

2 记录下 SSID。

使用接入点的 Macintosh（英文版）用户

1 在您的网页浏览器的地址栏中输入接入点的 IP 地址，然后继续进行步骤 2。

如果您不知道接入点的 IP 地址，请按照以下的步骤进行操作：

a 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

b 单击 Advanced 或 Configure。

c 单击 TCP/IP。
Router（路由器）项目通常即为接入点。

2 当出现提示时，请输入您的用户名和密码，然后单击 OK。

3 在“无线设置”区域中查找 SSID。

4 记录下 SSID、安全类型和 WEP 密钥／WPA 密钥（如果显示的话）。

注意：

• 请确认您准确地记录了网络信息，包括大写字母。

• 将 SSID 和 WEP 密钥／WPA 密钥保存在安全的地方，以备将来使用。

我可以同时通过 USB 连接和网络连接使用我的打印机吗？

是，打印机支持同时使用 USB 连接和网络连接。打印机可以按照以下方法进行配置：

• 本地连接（使用 USB 电缆连接在计算机上）

• 无线网络

• 同时使用无线网络和本地连接

什么是 MAC 地址？

媒体访问控制(MAC)地址是与网络设备的硬件相关联的一个 48 位标识符。MAC 地址也称为物理地址，因为它
与设备的硬件有关，而与软件无关。MAC 地址使用十六进制数字显示，格式为：01-23-45-67-89-AB。

虽然可以改变网络设备的 MAC 地址，但是通常不这样做。因此，MAC 地址被认为是固定不变的。IP 地址很
容易改变，因此 MAC 地址是识别网络中特定设备的更可靠的方法。

带有安全功能的路由器可以过滤网络中的 MAC 地址。此功能可以只允许指定的设备访问网络，由它们的 MAC
地址识别，也可以阻止来自不必要的设备的访问。如果您的网络使用了 MAC 地址过滤，请确认将打印机的
MAC 地址添加到允许设备列表中。
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我如何查找 MAC 地址？

网络设备都有一个唯一的硬件识别码，用于和网络中的其他设备区分开。这称为 MAC（媒体访问控制）地址。
其他设备有时使用一种称为统一管理地址(UAA)的 MAC 地址。

当您在网络中安装打印机时，请确认您选择了带有正确 MAC 地址的打印机。

内部打印服务器的 MAC 地址是一系列字母和数字。

MAC: XX  XX  XX  XX  XX  XX

注意：

• 您可以在接入点（无线路由器）上设置一个 MAC 地址列表，只允许 MAC 地址相符的设备使用网络。这
称为 MAC 过滤。如果您在您的接入点上启用了 MAC 过滤功能，并且希望将一台打印机添加到网络中，
打印机的 MAC 地址必须包含在 MAC 地址列表中。

• 如果您使用 AirPort 基站，MAC 地址可能称为 AirPort ID，MAC 地址过滤可以通过 MAC 地址访问控制
来实现。

什么是 IP 地址？

IP 地址是 IP 网络中的设备（例如无线打印机、计算机或无线接入点）所使用的一个唯一的号码，用于互相定
位和通讯。只有当 IP 网络中的设备有唯一且有效的 IP 地址时，设备之间才可以互相通讯。唯一的 IP 地址表
示在同一个网络中不会有两个设备有相同的 IP 地址。

IP 地址由 4 组数字组成，用小数点分开，例如 192.168.100.110。

什么是 TCP/IP？
当计算机、打印机和其他设备能够通过电缆或无线信号互相发送数据时，即表示网络开始工作了。使数据传输
成为可能的数据传输规则集合称为协议。协议可以被想象成带有规则的语言，以便参与者可以有效地相互沟
通。
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不同类型的网络使用不同的协议，但是传输控制协议/互联网协议(TCP/IP)是最普遍的。TCP/IP 用于通过互联
网以及大部分公司和家用网络发送数据。

使用 TCP/IP 的网络中的每台设备都必须具有 IP 地址。IP 地址是计算机的关键的、唯一的数字格式名称，用
于在网络上传输数据。IP 地址允许 TCP/IP 确认网络中各种设备请求和接收数据。

如何查找 IP 地址？

对于 Windows 用户

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击确定。

4 输入 ipconfig，然后按 Enter 键。

IP 地址由 4 组数字组成，用小数点分开，例如 192.168.0.100。

对于 Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

About This Mac > More Info

2 在 Contents 区域中选择 Network。

3 如果您是通过无线网络进行连接的，请从 Active Services 列表中选择 AirPort。

查找打印机的 IP 地址

• 从打印机打印网络设置页。

在 TCP/IP 区域中查找“地址”。

• 查看打印机设置。

从打印机操作面板，依次选择：

 > 设置 > OK  > 网络设置 > OK  > 无线 802.11 b/g/n > OK  > 网络连接设置 > OK  > TCP/IP > OK  > IP 地址 >
OK

IP 地址是如何指定的？

IP 地址可能由网络使用动态主机分配协议(DHCP)自动指定。当打印机在计算机上安装完毕后，计算机将会把
所有的打印作业按照此地址通过网络发送到打印机。

如果 IP 地址没有自动指定，在无线设置过程中，当您从可用的列表中选择您的打印机之后会要求您手动输入
地址和其他的网络信息。

什么是密钥索引？

一个接入点（无线路由器）最多可以配置 4 个 WEP 密钥。但是，每一次在网络中只使用一个密钥。密钥带有
一个编号，密钥的编号就是密钥索引。当接入点上配置了多个 WEP 密钥时，无线网络中的所有设备都必须使
用相同的密钥索引。

在您的打印机上选择您在接入点上使用的同一个密钥索引。
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向导设置和高级设置之间有什么区别？

请使用向导设置，如果：

• 打印机和计算机在同一无线网络中进行通信。

• 您希望 Wireless Setup Utility 自动检测网络。

• 您希望使用 Wi‑Fi Protected Setup(WPS)将打印机连接到无线网络中。

请使用向导设置，如果：

• 打印机和正在安装的计算机不在同一无线网络中，或如果该计算机没有无线接入点。

• 无线网络需要证书。

• 该无线网络应用了企业级安全性。

• 您知道网络 SSID 和安全信息，并且希望在单机屏幕上输入该信息。

• 打印机会被配置为可通过远程网络访问。

• 您知道网络信息并希望快速将其输入。

• 您正在为使用 802.1X 验证的无线网络配置打印机。
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维护打印机

维护打印墨盒
除了以下您可以完成的任务外，如果您的打印机连接在适当有效的接地式电源插座上，将会每周执行一次自动
维护操作。打印机将会暂时退出“睡眠”模式，或者将临时开机（如果打印机已关闭）。

查看墨水量

使用打印机操作面板

在打印机操作面板上依次选择：

 > 设置 > OK  > 维护 > OK  > 查看墨水量 > OK

使用打印机软件

对于 Windows 用户

1 单击 或开始。

2 单击所有程序或程序，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > 维护选项卡 > 耗材状态

对于 Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax > 选择您的打印机

2 单击 Options & Supplies 或 Print Queue。

3 单击 Supply Levels。

校正打印头

如果您打印的图像中的字符或线条出现锯齿状或波浪状，您可能需要校正打印头。

1 装入普通纸。

2 在打印机操作面板上依次选择：

 > 设置 > OK  >维护 > OK  > 校正打印机 > OK

打印机将会打印出一张校正测试页。

注意：打印完成之前，请不要移开校正测试页。

如果您是为了提高打印质量而校正打印墨盒，请重新打印您的文档。如果打印质量没有提高，请清洗打印头喷
头。
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清洗打印头喷头

如果长时间未使用打印机，您需要清洗打印头喷头，以提高打印的质量。请将打印机插入正确接地、有效的电
源插座上，以便进行周期性自动维护。

注意：

• 清洗打印头喷头将会使用墨水，因此请只在必要的时候进行清洗。

• 深度清洗将会使用更多的墨水，因此请首先尝试“清洗打印头”选项，以便节省墨水。

• 如果墨水量过低，您必须先更换打印墨盒，然后再清洗打印头喷头。

1 装入纸张。

2 在打印机操作面板上依次选择：

 > 设置 > OK  > 维护 > OK

3 反复按上下箭头按钮选择“清洗打印头”或“深度清洗打印头”，然后按 OK 。

打印机将会打印出一张清洗测试页。

清洗打印机的外壳
1 请确认打印机的电源已关闭，并且已从电源插座上断开。

当心—电击危险：当清洗打印机的外壳时，为了避免电击危险，请在操作之前从电源插座上断开电
源线，并断开打印机上的所有电缆。

2 从打印机内取出所有的纸张。

3 用水将一块干净且不掉毛的软布润湿。

警告—可能的损坏：请不要使用普通家用的清洁剂或去污剂，因为它们可能会损坏打印机的表面涂层。

4 请只清洗打印机的外面，并确认擦掉出纸托盘上的墨迹。

警告—可能的损坏：使用湿布清洗打印机的内部可能会损坏您的打印机。

5 在开始新的打印作业之前，请确认打印机完全干燥。
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清洁扫描仪玻璃
当打印页上出现垂直条纹或您在此类部件上看到污点或污迹时，请清洁扫描仪玻璃和其他相关部件。

1 用水将一块干净且不掉毛的软布润湿。

2 轻轻地清洁背面材料(1)和扫描仪玻璃(2)。

2

1

注意：确认文档上的所有墨水或纠正液都干透之后，再将文档放置在扫描仪玻璃上。

将打印机移到其他位置
将打印机移到其他位置时，请遵照以下注意事项：

• 确保已关闭打印机，并且从打印机断开了所有电缆。

• 用来移动打印机的拖车平台必须能够支持打印机底盘。

• 确保已经把出纸托盘插回到打印机。

• 确保打印机控制面板位于水平位置。

按打印机操作面板上的锁可以释放，然后将面板推回到输送位置。

2

1

维护打印机 88



• 保持打印机竖立以免墨水渗漏。

• 移动时避免严重颠簸。
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问题解答

在您解决问题之前
使用这些注意事项可以解决大多数打印机问题：

• 确认电源线的一端连接在打印机上，另一端连接在正确接地的电源插座上。

• 确认打印机的电源已打开。

• 确认打印机牢固地连接在计算机、打印服务器或其他网络接入点上。

• 检查打印机是否有错误信息，并解决错误。

• 检查是否有卡纸信息，并清除卡纸。

• 检查打印墨盒，如有必要，请安装新的打印墨盒。

• 关闭打印机电源，等待大约 10 秒钟后重新打开打印机电源。

注意：确认打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

如果问题解答没有解决您的问题
访问我们的国际互联网站 http://support.lexmark.com 查找以下内容：

• 包含有关您的打印机的最新信息和问题解答信息的知识库文章

• 在线技术支持

• 电话技术支持的联系号码

安装问题解答
• 第90 页“显示屏上的文字是错误的语言”

• 第91 页“软件不能安装”

• 第91 页“打印作业不打印或者缺页”

• 第92 页“打印机打印出空白页”

• 第93 页“打印机正忙或无反应”

• 第93 页“无法从打印队列中删除文档”

• 第94 页“无法通过 USB 进行打印”

显示屏上的文字是错误的语言

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

使用打印机菜单改变语言

1 在打印机操作面板上依次选择：

 > 设置 > OK  > 设备设置 > OK  > 语言 > OK

2 反复按上下箭头按钮选择希望的语言，然后按 OK 。
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3 如要确认设置，请按左右箭头按钮选择是，然后按 OK 。

软件不能安装

如果您在安装过程中遇到了问题、您的打印机没有出现在打印机文件夹中的列表里，或者发送打印作业时您的
打印机没有出现在打印机选项中，您可以尝试卸载并重新安装软件。

在您重新安装软件之前，请完成以下操作：

请确保您的计算机满足最低系统需求

在安装软件之前暂时禁用 WINDOWS 安全程序

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏，请换用新电缆。

2 将 USB 电缆上正方形的一端牢固地插入打印机后面的 USB 端口中。

3 将 USB 电缆上长方形的一端牢固地插入计算机的 USB 端口中。

USB 接口旁标有 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 端口。您可能连接到了有故障的端口上。

重新连接打印机电源

1 关闭打印机的电源。

注意：确保打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

2 从墙壁电源插座上拨出电源线，再将其从电源插口取出。

3 一分钟后，将电源线重新依次插入打印机电源插口和墙壁电源插座。

4 打开打印机的电源。

打印作业不打印或者缺页

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

请确认打印墨盒安装正确

1 打开打印机的电源，然后打开打印机。

2 请确认打印墨盒安装正确。

打印墨盒应该牢固地固定 在打印头上相应颜色的槽中。

3 关闭打印机。

发送打印作业之前，请在“打印”对话框中选择打印机

注意：此解决方案只适用于 Macintosh 用户。
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1 打开文档，选择 File > Print。

2 请从 Printer 弹出菜单中选择打印机，然后单击 Print。

如果您的打印机没有出现在 Printer 列表中，请选择 Add Printer。请从 Default 选项卡中的打印机列表
选择打印机，然后单击 Add。

如果您的打印机没有出现在列表中，请尝试以下任一操作：

• 对于 USB 连接的打印机，请断开并重新连接 USB 电缆。

• 对于以无线方式连接的打印机，请查看“无线问题解答”章节。

请确认打印作业没有被暂停

请确认将您的打印机设置为默认打印机

重新连接打印机电源

1 关闭打印机的电源。

注意：确认打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

2 从墙壁电源插座上拨出电源线，再将其从电源插口取出。

3 一分钟后，将电源线重新依次插入打印机电源插口和墙壁电源插座。

4 打开打印机的电源。

断开并重新连接您的打印机上的 USB 电缆

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏，请换用新电缆。

2 将 USB 电缆上正方形的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上长方形的一端牢固地插入计算机的 USB 接口中。

USB 接口旁标有 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 端口。您可能连接到了有故障的端口上。

移除并重新安装打印机软件

打印机打印出空白页

空白页可能是由于打印墨盒安装不正确所引起的。

重新安装打印墨盒并深度清洗和校正打印头

1 重新安装打印墨盒，请参阅第 12 页“更换打印墨盒” 以获取更多信息。

如果打印墨盒看起来不太合适，请确认打印头安装正确，然后重新尝试安装打印墨盒。

2 装入无标记的普通纸张。
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3 在打印机操作面板上依次选择：

 > 设置 > OK  > 维护 > OK

4 反复按上下箭头按钮选择“深度清洗打印头”，然后按 OK 。

打印机将会打印出一张清洗测试页。

5 装入无标记的普通纸张。

6 从“维护”菜单屏幕中，反复按上下箭头按钮选择“校正打印机”，然后按 OK 。

打印机将会打印出一张校正测试页。

注意：打印完成之前，请不要移开校正测试页。

打印机正忙或无反应

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

确保打印机没有处于“睡眠”模式

如果电源指示灯在缓慢闪烁，那么打印机正处于“睡眠”模式。按 以唤醒打印机。

如果打印机未从“睡眠”模式中恢复，那么请重置电源：

1 从墙壁电源插座中拔下电源线并等待 10 秒钟。

2 将电源线插入电源插座，然后打开打印机的电源。

如果仍出现该问题，那么请访问我们的网站，检查是否有您打印机软件或固件的更新。

重新连接打印机电源

1 关闭打印机的电源。

注意：确保打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

2 从墙壁电源插座上拨出电源线，再将其从电源插口取出。

3 一分钟后，将电源线重新依次插入打印机电源插口和墙壁电源插座。

4 打开打印机的电源。

无法从打印队列中删除文档

如果您的作业滞留在打印队列中无法删除，导致其他的作业不能打印，计算机和打印机可能无法进行通讯。

重新启动计算机并重新尝试

断开并重新连接您的打印机上的 USB 电缆
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无法通过 USB 进行打印

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

请确认 WINDOWS 中的 USB 端口已启用

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 devmgmt.msc。

3 按 Enter 键，或者单击“确定”。

设备管理器将会出现。

4 单击“通用串行总线控制器”旁边的加号(+)。

如果您看到 USB Host Controller 和 USB Root Hub 列在其中，说明 USB 端口已经正确启用。

请参阅计算机的相关文档获取更多的信息。

反安装并重新安装打印机软件

了解打印机信息

校正问题

请尝试以下方法：

• 检查打印墨盒。

1 打开打印机，取出打印墨盒并重新安装。

2 装入 A4 或 Letter 尺寸的普通纸张。

如果所用纸张上存在可能导致再次显示校正错误消息的标记，打印机都会读取。

3 关闭打印机。

4 请根据打印机型号，触摸确定或按 OK 。

• 按 以清除信息。
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无法逐份打印作业

请尝试以下一种或多种方法：

• 按 OK 继续打印保存在打印机内存中的页面，然后逐份打印剩下的打印作业。

• 按 取消当前打印作业。

更改为[尺寸]纸张

请尝试以下一种或多种方法：

• 在纸张支架中装入正确尺寸的纸张，然后按 OK 继续打印。

• 按 取消当前作业。

更改为[尺寸] [类型]纸张

请尝试以下一种或多种方法：

• 在纸张支架中装入正确尺寸和类型的纸张，然后按 OK 继续打印。

• 按 取消当前作业。

关闭打印机

打印机处于打开状态。关闭打印机以清除消息。

通信错误

打印机无法与请求的目的地通信。请尝试以下一种或多种方法：

• 确保您的打印机和计算机已经通过以太网或无线网络连接到 Internet。

• 确保打印机牢固地连接在主计算机、打印服务器或其他网络接入点上。

• 触摸确认以清除消息。
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打印墨盒错误

打印机无法验证一个或多个已安装的打印墨盒。请尝试以下一种或多种方法：

• 按 取消当前作业。

• 请仅使用原装 Lexmark 打印墨盒。

• 正确安装指定的打印墨盒。

• 关闭打印机电源，等待大约 10 秒钟后重新打开打印机电源。

注意：确保打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

• 请参阅用户手册，或访问 Lexmark 支持网站 http://support.lexmark.com 以获取更多信息。

打印墨盒缺失

请尝试以下一种或多种方法：

• 安装缺少的指定打印墨盒。

• 重新装入指定的打印墨盒。

• 按 OK 或 以清除信息。

• 请参阅用户手册，或访问 Lexmark 支持网站，网址为：http://support.lexmark.com，以获取支持的打印
墨盒列表。

不支持的打印墨盒

请尝试以下一种或多种方法：

• 用受打印机支持的打印墨盒替换无法识别的打印墨盒。

• 请仅使用原装 Lexmark 打印墨盒。

• 按 OK 或 以清除信息。

• 请参阅用户手册，或访问 Lexmark 支持网站 http://support.lexmark.com 以获取支持的打印墨盒列表。

墨水量偏低

您可能很快就需要更换指定的打印墨盒。请尝试以下一种或多种方法：

• 按 OK 或 清除信息并继续打印。

注意：根据您的打印机设置，您可能在更换指定的打印墨盒后才能继续打印。

• 请参阅用户手册，或访问 Lexmark 支持网站 http://support.lexmark.com 以获取支持的打印墨盒列表。

装入[尺寸]纸张

请尝试以下一种或多种方法：

• 在纸张支架中装入正确尺寸的纸张，然后按 OK 继续打印。

• 按 取消当前作业。
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装入[尺寸] [类型]纸张

请尝试以下一种或多种方法：

• 在纸张支架中装入正确尺寸和类型的纸张，然后按 OK 继续打印。

• 按 取消当前作业。

存储设备错误

请尝试以下一种或多种方法：

• 移除存储设备，然后重新将其插入卡插槽或 USB 端口。

• 触摸确定或按 OK 以清除信息。

网络[x]软件错误

[x]是该网络连接的号码。

请尝试以下一种或多种方法：

• 按 OK 以清除信息。

• 关闭并重新打开打印机电源以重置打印机。

打印机内存已满

请尝试以下一种或多种方法：

• 根据打印机型号，触摸确定或按 OK 以清除信息，然后重试打印。

• 在计算机中，调整打印机设置以降低打印作业质量，然后重试打印。

打印头无法移动

请尝试以下一种或多种方法：

• 打开打印机，移除打印头堵塞物，然后关闭打印机。

• 按 OK 以清除信息。
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打印头错误

取出并重新安装打印头

警告—可能的损坏：请勿用手直接触摸墨盒接触点以避免造成损坏和出现打印质量问题。

1 打开打印机，然后抬起保护盖。

1 2

2 取出打印头。

3 用干净且不掉毛的布清理打印头接触点和打印头拖车内的接触点。

4 重新装入打印头，然后关闭保护盖，直到其咔嗒 一声，卡入到位。

1 2

5 关闭打印机。

注意：如果取出打印头并将其重新装入还无法解决错误，请关闭并重新打开打印机电源。如果问题仍然存
在，请联系客户支持。
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缺少打印头

请尝试以下一种或多种方法：

• 安装打印头。

1 打开打印机，然后抬起保护盖。

1 2

2 装入打印头，然后关闭保护盖，直到其咔嗒一声，卡入到位。

注意：请确保将打印墨盒安装到打印头。如要获取更多的信息，请参阅用户手册中的“更换打印墨
盒”一章。

3 关闭打印机。

• 按 以清除信息。

• 如果您的打印机没带打印头，请访问 Lexmark 支持网站，网址为：http://support.lexmark.com，或联系
客户支持，以获取更多信息。

• 如果在已安装了打印头的情况下仍然出现该信息，请参阅用户手册中的“打印头错误”一章。
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不支持的打印头

请尝试以下一种或多种方法：

• 关闭并重新打开打印机。

• 安装支持的打印头。

1 打开打印机。

2 按释放按钮，然后取出打印墨盒。

1 21 2

3 抬起拖车保护盖。

21

4 取出不受支持的打印头。
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5 装入支持的打印头，然后关闭保护盖，直到其咔嗒 一声，卡入到位。

注意：请确保将打印墨盒安装到打印头。如要获取更多的信息，请参阅用户手册中的“更换打印墨
盒”一章。

6 关闭打印机。

• 访问 Lexmark 支持网站，网址为：http://support.lexmark.com ，或联系客户支持，以获取更多信息。

打印头警告

自打开打印机后，一个或更多打印墨盒缺失可能已超过两小时。

清理或深度清理打印头以恢复打印质量。

打印机将会打印出一张清洗测试页。

注意：

• 清洗打印头喷头将会使用墨水，因此请只在必要的时候进行清洗。

• 深度清洗将会使用更多的墨水，因此请首先尝试“清洗打印头”选项，以便节省墨水。

• 如果墨水量偏低，您必须先更换打印墨盒，然后才可以清洗打印头喷头。

• 请参阅用户手册，以获取更多关于如何清理打印头喷头的信息。

更换打印墨盒

请尝试以下一种或多种方法：

• 用受打印机支持的打印墨盒替换打印墨盒。

• 按 OK 以清除信息。

• 请参阅用户手册，或访问 Lexmark 支持网站 http://support.lexmark.com 以获取支持的打印墨盒列表。

扫描文档的时间过长

扫描作业超出最大页数。按 清除信息并取消当前扫描作业。

扫描仪已禁用

请尝试以下一种或多种方法：

• 请从打印机检查打印机软件设置或“管理”设置以启用扫描仪。

如需更多信息，请与客户支持联系。

• 按 OK 以清除信息。
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纸张尺寸太小

请尝试以下一种或多种方法：

• 请根据打印机型号，触摸确认或按 OK 。

• 确认纸张尺寸设置正确。

• 在进纸匣中或纸张支架上装入尺寸正确的纸张。

• 检查进纸导轨，确认在进纸匣或纸张支架上装入了正确的纸张。

• 取消当前打印作业。

标准网络软件错误

请尝试以下一种或多种方法：

• 按 OK 以清除信息。

• 关闭并重新打开打印机电源以重置打印机。

不可恢复的扫描错误

请尝试以下一种或多种方法：

• 重新启动您的打印机。

• 升级打印机固件。

不支持 USB 设备

移除并用受支持的设备替换无法识别的 USB 设备。

不支持的 USB 集线器

移除无法识别的 USB 集线器。

卡纸和进纸错误问题解答
• 第102 页“打印机内发生卡纸”

• 第104 页“纸张支架内发生卡纸”

• 第105 页“双面打印部件内发生卡纸”

• 第106 页“纸张或特殊介质进纸错误”

打印机内发生卡纸

注意：打印机的内部部件很灵敏。清除卡纸时，请避免对这些部件的不必要碰触。
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检查清除卡纸区域

1 抬起扫描仪部件。

2 取下卡纸清除盖板。

1 2 3

注意：

• 向下压按钮以抬起卡纸清除盖板。

• 请确保将打印头移到一边，使其远离被卡住的纸张。

3 抓紧纸张的两面并将其轻轻地从打印机中拉出。

注意：确认已取出所有纸张碎片。
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4 重新关闭卡纸清除盖板直到其咔嗒一声，卡入到位。

1 2

5 关闭打印机。

6 请根据打印机型号，触摸确定或按 OK 。

出纸托盘卡纸

1 抓紧纸张并将其轻轻地从打印机中拉出。

注意：确认已取出所有纸张碎片。

2 请根据打印机型号，触摸确定或按 OK 。

纸张支架内发生卡纸

注意：打印机的内部部件很灵敏。清除卡纸时，请避免对这些部件的不必要碰触。
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1 取出纸张支架。

2 抓紧纸张并将其轻轻地从打印机中拉出。

注意：确认已取出所有纸张碎片。

3 重新装入纸张支架，直到其咔嗒一声，卡入到位。

4 请根据打印机型号，触摸确定或按 OK 。

双面打印部件内发生卡纸

注意：打印机的内部部件很灵敏。清除卡纸时，请避免对这些部件的不必要碰触。
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1 向下拉双面锁，然后取下双面打印部件。

1

2

2 抓紧纸张并将其轻轻地从打印机中拉出。

注意：小心不要在取出卡纸时将其撕坏。

3 重新装入双面打印部件，直到其咔嗒一声卡入到位，以清除信息。

4 如有必要，请根据打印机型号，触摸确定或按 OK 。

纸张或特殊介质进纸错误

如果纸张或特殊介质进纸不正常、扭曲、同时进多页纸或者粘在一起，以下是可能的解决方法。请尝试其中的
一种或多种方法：

检查纸张条件

请只使用新的且没有皱褶的纸张。

检查纸张装入
• 请在打印机内装入较少数量的纸张。

• 装入纸张时请确认可打印的一面朝上。（如果您不确定哪一面可打印，请参阅随同纸张一起的指导。）

• 请参阅针对您的纸张和特殊介质的详细装纸指导。
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随时移开打印机送出的打印页

调节进纸导轨以适合装入的纸张

打印问题解答
• 第107 页“打印页边缘处的打印质量非常差”

• 第108 页“打印的图像中出现条纹或线条”

• 第108 页“打印速度慢”

• 第109 页“当打印时计算机速度变慢”

打印页边缘处的打印质量非常差

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

检查最小打印设置

除非您使用无边界功能，否则请使用以下的最小打印边距设置：

• 左边距和右边距：

– Letter 尺寸的纸张：6.35 毫米（0.25 英寸）

– 除 Letter 以外的所有其他纸张：3.37 毫米（0.133 英寸）

• 上边距：1.7 毫米（0.067 英寸）

• 下边距：12.7 毫米（0.5 英寸）

选择无边界打印功能

对于 Windows 用户

1 打开照片，单击文件 > 打印。

2 单击属性、首选项、选项或设置。

3 依次选择：

纸张/完成 选项卡 >选择无边界设置 > 确定

4 单击打印。

对于 Macintosh（英文版）用户

1 打开照片，选择 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择名称中带有(Borderless)的纸张尺寸。

例如，如果您装入了一张 4 x 6 照片纸，那么请选择 US 4 x 6 in (Borderless)。

4 单击 OK。

5 从菜单栏中单击 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

问题解答 107



7 从打印选项弹出菜单中选择 Quality & Media。

8 从 Paper Type 弹出菜单中选择纸张类型。

9 从 Print Quality 弹出菜单中选择 Best 或 Photo。

10 单击 Print。

打印的图像中出现条纹或线条

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

查看墨水量

更换墨水量偏低或空的打印墨盒。

在打印机软件中选择较高的打印质量

请确认打印墨盒安装正确

校正打印头

清洗或深度清洗打印头喷头

注意：如果这些方法不能去除打印的图像中的条纹或线条，请联系技术支持。

打印速度慢

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

在打印机软件中选择较低的打印质量

手动选择您使用的纸张类型

反安装并重新安装打印机软件

提高计算机处理速度
• 请关闭所有不用的应用程序。

• 尽量减小文档中照片和图像的数量和尺寸。

为计算机增加内存

考虑升级内存(RAM)。
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当打印时计算机速度变慢

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

检查打印机和计算机之间的 USB 连接

如果您的计算机通过 USB 电缆连接在打印机上，请尝试使用不同的 USB 电缆。

刷新您的网络连接

1 如果您的计算机连接在以太网或无线网络中，请关闭接入点（无线路由器）的电源，然后重新打开。

2 等待 1 分钟，让打印机和计算机重新建立连接。

请关闭所有不用的应用程序

在您的计算机上临时关闭不用的应用程序或结束占用太多内存的进程。

检查您的计算机性能

您可能需要改变您的计算机如何管理资源和进程。

如要获取更多有关提高计算机性能的帮助信息，请参阅您的操作系统的帮助文档。

复印和扫描问题解答
• 第109 页“打印机不能复印或扫描或者没有反应”

• 第109 页“扫描仪部分没有关闭”

• 第110 页“复印或扫描的质量非常差”

• 第110 页“文档或照片只复印或扫描了一部分”

• 第110 页“扫描不成功”

• 第111 页“扫描任务花费很长的时间或者导致死机”

• 第111 页“无法通过网络扫描至计算机”

打印机不能复印或扫描或者没有反应

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

将您的打印机设置为默认打印机

反安装并重新安装打印机软件

扫描仪部分没有关闭

1 抬起扫描仪部分。

2 取出所有导致扫描仪部分打开的堵塞物。

3 关闭扫描仪部分。
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复印或扫描的质量非常差

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

擦洗扫描仪玻璃

在打印机软件中调整扫描质量

浏览有关复印和扫描的提示以提高打印质量

使用更清晰的文档或图像原件

请确认文档或照片正面朝下放置在扫描仪玻璃上，并且位于正确的角落

文档或照片只复印或扫描了一部分

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认文档或照片正面朝下放置在扫描仪玻璃上，并且位于放置角落

选择您装入的纸张尺寸

请确认“原件尺寸”设置与您要扫描的文档尺寸一致

扫描不成功

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏，请换用新电缆。

2 将 USB 电缆上正方形的一端牢固地插入打印机后面的 USB 端口中。

3 将 USB 电缆上长方形的一端牢固地插入计算机的 USB 端口中。

USB 接口旁标有 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 端口。您可能连接到了有故障的端口上。

重新启动计算机
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扫描任务花费很长的时间或者导致死机

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

关闭其他不用的应用程序

重新启动计算机

无法通过网络扫描至计算机

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认打印机和目的地计算机连接在同一个网络中

请确认在目的地计算机上安装了打印机软件

网络问题解答
• 第113 页“无线问题解答注意事项”

• 第111 页“'继续'按钮无法使用”

• 第113 页“无法打印并且计算机上安装了防火墙”

• 第113 页“当连接到虚拟个人网络(VPN)时与打印机的通讯中断了”

“继续”按钮无法使用

请以出现的顺序依次尝试以下解决方案，直到“继续”按钮激活激活并可用：

检查 USB 电缆是否牢固地连接到了计算机和打印机的 USB 端口上

USB 端口带有 标记。

请确认打印机已接通电源并且已打开

请确认 按钮指示灯亮着。如果您刚刚打开打印机，那么可能需要断开 USB 电缆然后重新连接。

请确认计算机上的 USB 端口可以正常工作

通过连接到其它设备来测试 USB 端口。如果可以通过端口使用其他设备，那么端口可以正常工作。

注意：

• 您的端口可能运行良好，但连接到多种 USB 设备的时候可能会发生某些冲突。请尝试断开其中某个
USB 设备。

• 如果计算机上的某个 USB 端口不能正常工作，请尝试使用计算机上的其它 USB 端口。
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请确认 USB 电缆可以正常工作

尝试使用不同的 USB 电缆。如果您使用的电缆长度超过 10 英尺，那么请尝试短一些的电缆。

注意：USB 转换器、扩展电缆、端口复制器和扩展坞都可能引起连接问题。请尝试断开这些设备，使打印
机可以直接连接到计算机。

请确认您使用的是针对您的打印机型号的正确的 CD
比较 CD 上的打印机型号和打印机上的打印机型号。号码应该完全相同或属于同一系列。

如果不能确定，请在 Lexmark 网站上搜索最新版本的打印机软件。如要获取更多的信息，请参阅打印机用
户指南。

重新连接打印机电源

1 关闭打印机的电源。

注意：确保打印机没有处于“睡眠”模式。按住 按钮 3 秒钟以关闭打印机。

2 从墙壁电源插座上拨出电源线，再将其从电源插口取出。

3 一分钟后，将电源线重新依次插入打印机电源插口和墙壁电源插座。

4 打开打印机的电源。

再次运行安装程序

1 关闭安装程序。

2 取出 CD，然后重新启动计算机。

3 插入 CD，然后再次运行安装程序。

请确认您的计算机能够注意到 USB 端口上的 USB 活动

打开“设备管理器”，检查 USB 设备连接到 USB 端口之后是否活动：

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入 devmgmt.msc。

3 按输入键，或者单击确定。

4 将 USB 电缆或其他设备连接到 USB 端口时，查看“设备管理器”窗口。“设备管理器”检测到 USB
连接后，会刷新窗口。

• 如果“设备管理器”可以检测到活动，但之前的解决方案都无法正常工作，那么请电话联系客户支
持。

• 如果“设备管理器”检测不到活动，那么您的计算机和它的 USB 支持可能出现了问题。为了正常安
装，计算机必须能够检测到 USB 连接。
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无法打印并且计算机上安装了防火墙

第三方（非 Microsoft）的防火墙可能会干扰无线打印。如果打印机和计算机都配置正确，并且无线网络可以
正常工作，但是打印机不能进行无线打印，可能是防火墙的问题。如果计算机上安装了防火墙（除 Windows
防火墙以外），请尝试以下的一种或多种方法：

• 使用制造商提供的最新的升级包升级防火墙。请参阅随同您的防火墙一起提供的帮助文档了解如何操作。

• 当您安装打印机或者尝试打印时，如果程序向防火墙请求访问，请确认您允许这些程序运行。

• 临时禁用防火墙，然后在计算机上安装无线打印机。当您完成无线安装后，重新启用防火墙。

当连接到虚拟个人网络(VPN)时与打印机的通讯中断了

当您连接到大多数虚拟个人网络(VPN)时，与您的本地网络中的无线打印机的连接将会中断。大多数 VPN 只
允许用户与 VPN 进行通讯，不可以同时与其他网络进行通讯。如果您希望可以同时连接到您的本地网络和
VPN，VPN 的系统支持人员必须启用 Split Tunneling（分离通道）功能。请注意，一些机构组织出于安全或
技术的原因不允许使用此功能。

无线问题解答
• 第114 页“无法通过无线网络进行打印”

• 第117 页“没有安装无线打印服务器”

• 第117 页“当进行无线打印时出现'无法通讯'信息”

• 第 113 页“当连接到虚拟个人网络(VPN)时与打印机的通讯中断了”

• 第119 页“解决间歇无线通讯问题”

无线问题解答注意事项

在开始无线打印机的问题解答之前，请确认以下事项：

• 打印机、计算机和接入点（无线路由器）都接通电源，并且电源已打开。

• 无线网络可以正常工作。

尝试访问您的无线网络中的其他计算机。

如果您的网络可以访问 Internet，请尝试通过无线连接到 Internet。

• 您的 SSID 是正确的。

打印一张网络设置页，检查打印机所使用的 SSID。

如果您不确定您的 SSID 是否正确，请重新进行无线设置。

• 您的 WEP 密钥或 WPA 密钥是正确的（如果您的网络是安全加密的）。

登录接入点并检查安全设置。

安全密钥类似于密码。在同一个无线网络中，所有使用 WEP、WPA 或 WPA2 安全性的设备共用一个相同
的安全密钥。

如果您不确定您的安全信息是否正确，请重新进行无线设置。

• 打印机和计算机位于无线网络范围内。

对于大多数网络来说，打印机和计算机应该位于距离接入点（无线路由器）100 英尺（30 米）以内的地
方。

• Wi‑Fi 指示灯是绿色的并且成功连接。

• 在您要使用打印机的计算机上安装了打印机驱动程序。

• 您选择了正确的打印机端口。
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• 计算机和打印机连接在同一个无线网络中。

• 打印机远离可能干扰无线信号的障碍物或电子设备。

请确认打印机和接入点之间没有包含金属或混凝土的杆棒、墙壁或支柱。

很多设备可以干扰无线信号，包括婴儿监视器、发动机、无线电话、安全系统照相机、其他的无线网络和
一些蓝牙设备。

无法通过无线网络进行打印

如果您在安装过程中遇到了问题、您的打印机没有出现在打印机文件夹中、或者发送打印作业时您的打印机没
有出现在打印机选项中，您可以尝试卸载并重新安装软件。

在您重新安装软件之前，请先检查问题解答注意事项，然后尝试以下的方法：

关闭并重新打开接入点（无线路由器）

等待 1 分钟，让打印机和计算机重新建立连接。此操作有时可以刷新网络连接，解决连接问题。

从虚拟个人网络(VPN)上断开连接

当您通过 VPN 连接在其他网络中时，您将不能在您的无线网络中访问打印机。请结束您的 VPN 会话，然
后重新尝试打印。

请确认“演示模式”已禁用

当“演示模式”启用时，一些打印机功能将无法使用。

在打印机操作面板上依次选择：

 > 设置 > OK  > 演示模式 > OK  > 关 > OK

检查您的 WEP 密钥或 WPA 密钥

如果您的接入点使用 WEP 安全性，WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的符号。WEP 密钥中的 ASCII
字符需要区分大小写。

如果您的接入点使用 WPA 或 WPA2 安全性，WPA 密钥应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的符号。WPA 密钥中的 ASCII 字
符需要区分大小写。

注意：如果您不了解这些信息，请参阅随同接入点一起提供的帮助文档，或者联系您的系统支持人员。

检查接入点上是否有关联/注册按钮

在欧洲、中东和非洲，当您向您的无线网络中添加打印机时，无线宽带 box（例如 LiveBox、AliceBox、
N9UF Box、FreeBox 或 Club Internet）可能会要求您按关联/注册按钮。

如果您使用这些 box 并需要更多信息，请参阅随您的 box 一起提供的帮助文档，或者与您的 Internet 服务
供应商(ISP)联系。
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移动您的无线接入点，使之远离其他电子设备

一些电子设备（例如微波或其它电器用具、无线电话、婴儿监视器和安全系统照相机）可能会产生临时的干
扰。请确认您的无线接入点没有放置在距离这些设备很近的地方。

将计算机和/或打印机移动到距离接入点比较近的地方

您的无线网络范围取决于很多因素，包括接入点和网络适配器的能力。如果您在打印时遇到问题，请尝试调
整计算机和打印机的位置，使它们之间的距离不超过 100 英尺。

检查无线信号质量

打印网络设置页并检查信号质量。如果列出的信号质量是好或者很好，说明导致此问题的是其他因素。

检查您的高级安全设置
• 如果您要使用 MAC（媒体访问控制）地址过滤功能来限制其他人对您的无线网络的访问，您必须将打印
机的 MAC 地址添加到可以连接到接入点的地址列表中。

• 如果您要设置接入点只分配有限数量的 IP 地址，必须先改变此设置，然后才能添加打印机。

注意：如果您不了解如何进行这些改变，请参阅随同接入点一起提供的帮助文档，或者与无线网络的安装
人员联系。

请确认您的计算机连接在您的接入点上
• 打开您的 Web 浏览器并访问任意网站，确定您是否可以访问 Internet。

• 如果您的无线网络中有其他的计算机或资源，请检查并确认您是否可以从您的计算机上对其进行访问。

请确认您的计算机和打印机连接在同一个无线网络中

如果打印机和计算机不在同一个无线网络中，您将不能进行无线打印。如果计算机已经连接在无线网络中，
打印机的 SSID 必须与计算机的 SSID 一致。

对于 Windows 用户

1 获取计算机所连接的网络的 SSID。

a 在您的 Web 浏览器的地址栏中输入您的接入点的 IP 地址。

如果您不知道接入点的 IP 地址：

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击确定。

4 输入 ipconfig，然后按 Enter 键。查看“无线网络连接”部分：

• Default Gateway（默认网关）项目通常即为接入点。

• IP 地址由 4 组数字组成，用小数点分开，例如 192.168.2.134。

b 当出现提示时，请输入接入点的用户名和密码。

c 单击确定。

d 在“无线设置”部分查找 SSID。

e 记录 SSID。

注意：请确认您准确记录了所有内容，包括大写字母。
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2 获取打印机所连接的网络的 SSID：

a 从打印机打印网络设置页。

b 在“无线”部分查找 SSID。

3 比较计算机和打印机的 SSID。

如果 SSID 相同，说明计算机和打印机连接在同一个无线网络中。

如果 SSID 不相同，请重新运行实用程序，在计算机所使用的无线网络中安装打印机。

对于使用 AirPort 基站的 Macintosh（英文版）用户

Mac OS X version 10.5 或更高版本

1 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

计算机所连接的网络的 SSID 将会显示在 Network Name 菜单中。

2 记录 SSID。

Mac OS X version 10.4 或更早版本

1 从 Finder 中依次选择：

Applications > Internet Connect > AirPort

计算机所连接的网络的 SSID 将会显示在 Network 菜单中。

2 记录 SSID。

对于使用接入点的 Macintosh（英文版）用户

1 在您的 Web 浏览器的地址栏中输入接入点的 IP 地址，然后继续进行步骤 2。

如果您不知道接入点的 IP 地址，请按照以下的步骤进行操作：

a 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

b 单击 Advanced 或 Configure。

c 单击 TCP/IP。
Router（路由器）项目通常即为接入点。

2 当出现提示时，请输入您的用户名和密码，然后单击确定。

3 在“无线设置”部分查找 SSID。

4 记录下 SSID、安全类型和 WEP 密钥/WPA 密钥（如果显示）。

注意：

• 请确认您准确地记录了网络信息，包括大写字母。

• 将 SSID 和 WEP 密钥/WPA 密钥保存在安全的地方，以备将来查看。

请确认您的操作系统适用于通过 AIRPORT 的无线打印

打印机只支持在 Mac OS X version 10.5 或更高版本（英文版）中通过 AirPort 基站进行无线打印。
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没有安装无线打印服务器

在安装过程中，您可能会看到一条信息，提示您打印机没有安装无线打印服务器。如果您不确定打印机是否可
以进行无线打印，请尝试以下的方法：

检查电源

请确认  指示灯亮着。

当进行无线打印时出现“无法通讯”信息

请尝试以下一种或多种方法：

请确认您的计算机和打印机都有适合于网络的有效 IP 地址

如果您使用的是便携式笔记本电脑，并且启用了节约能源设置，当您尝试进行无线打印时，您可能会在笔记
本电脑的屏幕上看到“无法通讯”信息。如果笔记本电脑的硬盘处于节能模式，可能会发生此情况。

如果您看到了此信息，请等待几秒钟，然后重新尝试打印。笔记本电脑和打印机需要几秒钟的时间才可以恢
复正常模式并重新连接到无线网络。

如果您等待了足够长的时间让笔记本电脑和打印机连接网络，但是仍然看到了此信息，可能是您的无线网络
出现了问题。

请确认笔记本电脑和打印机都接收到了 IP 地址：

对于 Windows 用户

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击确定。

4 输入 ipconfig，然后按 Enter 键。

IP 地址由 4 组数字组成，用小数点分开，例如 192.168.0.100。

对于 Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

About This Mac > More Info

2 在 Contents 区域中选择 Network。

3 如果您是通过无线网络进行连接的，请从 Active Services 列表中选择 AirPort。

Router（路由器）项目通常即为接入点。

查找打印机的 IP 地址

• 从打印机打印网络设置页。

在 TCP/IP 区域中查找“地址”。

• 查看打印机设置。

从打印机操作面板，依次选择：

 > 设置 > OK  > 网络设置 > OK  > 无线 802.11 b/g/n > OK  > 网络连接设置 > OK  > TCP/IP > OK  >
IP 地址 > OK
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如果打印机或笔记本电脑没有 IP 地址，或者 IP 地址是 169.254.x.y（其中 x 和 y 是 0–255 之间的任意两个
数字），请执行以下操作：

1 关闭没有有效 IP 地址的设备（笔记本电脑、打印机、或者全部）。

2 打开设备，然后再次检查 IP 地址。

如果打印机或笔记本电脑仍然没有接收到有效的 IP 地址，可能是您的无线网络出现了问题。请尝试以下方
法：

• 请确认您的接入点（无线路由器）的电源已打开，并且可以正常工作。

• 移开所有可能阻止信号的物体。

• 临时关闭网络中所有不必要的无线设备，并暂停所有网络密集型活动，例如大文件传输或网络游戏。如
果网络太忙，打印机有可能在允许的时间内接收不到 IP 地址。

• 请确认您的 DHCP 服务器（也可能是您的无线路由器）可以正常工作，并且经过了配置，可以分配 IP
地址。如果您不确定如何操作，请参阅随同您的无线路由器一起提供的手册。

如果打印机和计算机都有有效的 IP 地址，并且网络工作正常，请继续进行问题解答操作。

请确认您选择了无线端口

注意：此方法只适用于 Windows 用户。

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入控制打印机。

3 按 Enter 键，或者单击确定。

4 右键单击打印机图标，然后从菜单中单击属性或打印机属性。

5 单击端口选项卡，然后查找选定端口。

在“端口”列中选定的端口旁有一个选中标记。

6 如果选定端口的“描述”列表明它是一个 USB 端口，请快速查看列表并从中选择“描述”列是“打印机
端口”的端口。请检查“打印机”列中的打印机型号，确认您选择了正确的打印机端口。

7 单击确定，然后重新尝试打印。

请确认双向通讯已启用

注意：此方法只适用于 Windows 用户。

1 单击 ，或单击开始，然后单击运行。

2 在“开始搜索”或“运行”框中输入控制打印机。

3 按 Enter 键，或者单击确定。

4 右键单击打印机图标，然后从菜单中单击属性或打印机属性。

5 单击端口选项卡。

6 请选中启用双向支持旁边的框（如果尚未选中）。

7 单击应用 > 确定，然后重新尝试打印。
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解决间歇无线通讯问题

尽管您的无线网络中明显没有任何改变，您可能会注意到您的打印机工作了一小段时间，然后停止了工作。

很多不同的问题可以中断网络通讯，并且有时多个问题同时存在。请尝试其中的一种或多种方法：

当您尝试使用无线网络时，请从所有的 VPN 上断开连接

大多数虚拟个人网络(VPN)只允许计算机与 VPN 进行通讯，不可以同时与其他网络进行通讯。在计算机上
安装驱动程序或者在计算机上运行无线设置之前，请从 VPN 上断开连接。

如要检查计算机现在是否连接在 VPN 中，请打开您的 VPN Client 软件并检查您的 VPN 连接。如果您没有
安装 VPN Client 软件，请使用 Windows VPN Client 手动检查连接。

如果您希望可以同时连接到您的本地网络和 VPN，请要求 VPN 的系统支持人员允许使用 Split Tunneling
（分离通道）功能。请注意，一些机构组织出于安全或技术的原因不允许使用此功能。

关闭接入点（无线路由器）的电源，然后重新打开

等待 1 分钟，让打印机和计算机重新建立连接。此操作有时可以刷新网络连接并解决连接问题。

消除网络拥堵

如果无线网络太忙，计算机和打印机可能很难互相通讯。导致无线网络拥堵的原因可能包括：

• 通过网络传输很大的文件

• 网络游戏

• 点对点文件交换应用程序

• 流视频

• 无线网络中同时存在太多的计算机

消除干扰源

普通家庭用品有可能会中断无线网络通讯。位于无线网络附近的无线电话（不包括手机）、微波炉、婴儿监
视器、几乎所有的厨房用具、无线监视设备以及任何包含发动机的用具都有可能会中断无线网络通讯。

请尝试打开这些可能的干扰源，看它们是否导致了问题。如果是，请将您的无线网络与这些设备分开。

改变接入点使用的频道

有时候您可以通过改变您的接入点用于广播的频道来消除来自未知来源的干扰。路由器上有 3 个独特的频
道。请参阅随同您的路由器一起提供的帮助文档确定是哪三个。其他的频道作为可选项提供，但是它们是互
相交迭的。如果路由器配置为使用默认设置，请改变频道设置，使用不同的独特频道。如果您不确定如何改
变频道，请参阅随同您的接入点一起提供的帮助文档。

使用唯一的 SSID 配置接入点

很多无线网络使用路由器制造商最初为路由器配置的 SSID。当使用相同 SSID 的多个网络在同一个区域内
共同工作时，使用默认的 SSID 可能会导致出现问题。尽管会显示正在尝试连接到正确的网络，但是打印机
或计算机可能会尝试连接到错误的网络。

如要避免出现这种类型的干扰，请在您的接入点上改变 SSID，不要使用默认值。如果您不确定如何改变
SSID，请参阅随同您的接入点一起提供的帮助文档。

注意：如果您在接入点上改变了 SSID，您必须在所有访问您的无线网络的其他设备上改变 SSID。
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为网络中的所有设备指定静态 IP 地址

大多数无线网络使用无线路由器内置的 DHCP（动态主机分配协议）服务器为无线网络中的用户分配 IP 地
址。DHCP 地址在需要的时候才会分配，例如当新的设备添加到无线网络中或者当设备打开电源时。无线设
备必须向路由器发送请求，然后接收一个 IP 地址，以便可以在网络中工作。由于无线路由器除了分配地址
以外还要完成很多其他的任务，有时可能不会很快地响应并分配地址。请求的设备有时会在接收到地址之前
就放弃了。

请尝试为您的网络中的设备指定静态 IP 地址以解决此问题。

如要为打印机指定一个静态 IP 地址：

1 完成无线设置，允许打印机从网络中的 DHCP 服务器接收一个 DHCP 地址。

2 打印一张网络设置页，查看当前为打印机分配的 IP 地址。

3 打开网络浏览器，然后在地址栏中输入打印机的 IP 地址。按 Enter 键。

4 单击“配置 > TCP/IP > 设置静态 IP 地址”。

5 在“地址”字段中输入您希望为打印机指定的 IP 地址，然后单击“提交”。

在网络浏览器的地址栏中输入静态 IP 地址并查看打印机网页是否可以打开，以确认 IP 地址是否已更新。如
要获取更多有关指定静态 IP 地址的帮助信息，请参阅随同您的路由器和操作系统一起提供的帮助文档。

查看接入点的已知问题

一些无线路由器带有明确的缺陷，已经得到了制造商的验证和确认。请访问路由器制造商的公司网站。从制
造商了解固件升级信息和其他的建议。如果您不确定如何访问制造商网站，请参阅随同您的无线路由器一起
提供的帮助文档。

检查无线网络适配器升级

如果您从一台特别的计算机打印时遇到了问题，请查看计算机中的无线网络适配器卡的制造商网站。网站上
可能有升级的驱动程序，可以解决问题。

将所有的网络设备改变为相同的类型

虽然在同一个无线网络中可以成功地同时包含 802.11b、802.11g 和 802.11n 设备，但是较快的设备有时会
阻止较慢的设备进行通讯。

请尝试只打开相同类型的网络设备，看网络通讯是否有所改善。如果此方法可以解决问题，您可能需要使用
较新的无线网络适配器升级您的较旧的设备。

购买一个新的路由器

如果您的路由器已经使用了很多年，它可能无法与您的网络中较新的无线设备完全兼容。请考虑购买一个可
以完全兼容 802.11 IEEE 规范的较新的路由器。
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注意事项

产品信息

产品名称：

Lexmark S310 Series

机器类型：

4448

型号：

S310 Series: 301, 30E

版本注意事项

2011 年 10 月

以下文字如果与当地法律法规有所冲突，可能并不适用于那些地区：LEXMARK INTERNATIONAL, INC.以其
现状提供此手册，并没有任何保证（不论明示的或暗示的），包括，但不限于以其特定目的进行销售及适用的
暗示保证。某些司法管辖区并不准许在某些交易中排除明示的或暗示的保证；因此，这份声明可能并不适用于
你方。

本手册中可能会有技术上的不准确或印刷错误。鉴于此，本手册中的内容会阶段性地更新；这些改动将会体现
在以后的版本中。产品或程序有可能会随时改动，如有改动，恕不另行通知。

本手册中提到的有关产品、程序或服务等并不意味着生产厂商打算将这些产品、程序或服务向所有的国家提
供，也不意味着只能使用此产品、程序或服务。任何功能一样的产品、程序或服务，只要不侵犯现有的知识产
权，都可以用来替换使用。与其他的产品、程序或服务（除厂商明确标明外）共同操作并进行评估与验证是用
户的责任。

如要获取 Lexmark 技术支持，请访问网站 support.lexmark.com。

如要获取有关耗材和下载的信息，请访问网站 www.lexmark.com。

如果您不能访问 Internet，您可以通过邮件与 Lexmark 联系：

Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550
USA

© 2011 Lexmark International, Inc.

All rights reserved. 保留所有权利。

商标

Lexmark 和带有钻石图案的 Lexmark 标记都是 Lexmark International, Inc.在美国和／或其他国家注册的商标。

PerfectFinish 是 Lexmark International, Inc.的商标。
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Mac 和 Mac 徽标都是 Apple Inc.在美国和／或其他国家注册的商标。

PCL®是 Hewlett-Packard 公司的注册商标。PCL 是 Hewlett-Packard 公司的打印机产品中包含的一组打印机
命令（语言）和函数的名称。此打印机可与 PCL 语言兼容。这意味着此打印机可识别各种应用程序中使用的
PCL 命令，并且此打印机可模拟与这些命令对应的功能。

其他商标分别属于各自所属者所有。

AirPrint 和 AirPrint 徽标是 Apple, Inc. 的商标。

模块组件注意事项

本产品可能包含下列模块组件：

Lexmark 管理机型/型号 LEX-M01-004；FCC ID：IYLM01004；Industry Canada IC：2376A-M01004

许可注意事项

所有与此产品关联的许可注意事项可以从安装软件 CD 的 CD:\LEGAL 目录查看。

噪声等级

以下的测量是依照 ISO 7779 进行的，并且所做的报告完全符合 ISO 9296 的标准。

注意：一些模式可能不适用于您的产品。

1 米平均声压（分贝）

打印 50 dBA

扫描 47 dBA

复印 47 dBA

准备就绪 无声

数值可能会随时变化。请参阅 www.lexmark.com 获取当前的数值。
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废弃电子电气设备（WEEE）指令

WEEE 徽标表示欧盟各国对电子产品采取的特殊回收计划和程序。我们鼓励回收我们的产品。

如果您对回收选项有更多的问题，请访问 Lexmark 的 Web 站点：www.lexmark.com 以获取当地的销售商电
话号码。

产品处理

请勿按处理日常生活垃圾的方法来处理打印机或消耗品。请咨询您当地的权威机构以了解处理和回收选项。

电池通告

此产品包含高氯酸盐材料，可能需要特殊的处理方法。请访问网站
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/获取更多的信息。

静电灵敏度注意事项

此符号表示对静电敏感的部件。请先接触打印机的金属外框，再接触这些符号附近的区域。

ENERGY STAR
在产品上或者在启动屏幕上带有 ENERGY STAR 标志的任何 Lexmark 产品已经认证在由 Lexmark 出厂时其
配置符合美国环保署（EPA）的 ENERGY STAR 要求。
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中国 RoHS 计划的信息

部件名称 有毒及有害物质或元素

铅（Pb） 汞（Hg） 镉（Cd） 六价铬（Cr VI） 多溴联苯（PBB） 多溴二苯醚（PBDE）

电路板 X O O O O O

电源 X O O O O O

电源线 X O O O O O

连接器 X O O O O O

机械配件—杆、辊 X O O O O O

机械配件—电机 X O O O O O

机械配件—其他 X O O O O O

扫描仪配件 X O O O O O

LCD 显示屏 X O O O O O

O：表示部件的所有同质材料中有毒和有害物质的含量低于 SJ/T11363-2006 中描述的浓度限制要求。

X：表示部件中至少一种同质材料中的有毒和有害物质含量高于 SJ/T11363-2006 中描述的浓度限制要求。

此产品符合欧盟指令 2002/95/EC 中有关某些有害物质使用的限制。

温度信息

室温 15 ~ 32℃（60 ~ 90℉）

运输和存储温度 -40 ~ 60℃（-40 ~ 140℉），1 ~ 60℃（34 ~ 140℉）

功耗

产品功耗

下表记录了该产品的功率消耗特性。

注意：一些模式可能不适用于您的产品。

模式 描述 功耗（瓦特）

打印 产品正在从电子输入生成硬拷贝输出。 15.9

副本 产品正在从硬拷贝的原始文档生成硬拷贝输出。 15.2

扫描 产品正在扫描硬拷贝文档。 11.0

就绪 产品正在等待打印作业。 5.75

睡眠模式 产品处于高级别能源节省模式。 2.75

关 产品已被插入墙壁电源插座中，但电源开关被关闭。 0.33

前面表格中列出的功耗水平表示平均时间测量值。瞬时功率拉升可能远远超过平均水平。

值可能会有所变化。请参阅 www.lexmark.com 上的当前值。
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省电模式

本产品被设计为使用一种称为“省电模式”的能源节省模式。“省电模式”相当于“睡眠模式”。“省电模
式”通过在长期不活动时间内减少电力消耗来节约能源。本产品在指定时间段（称为“省电模式超时”）未被
使用后自动进入“省电模式”。

本产品的出厂默认“省电模式超时”（以分钟为单位）： 60

通过使用配置菜单，可以在 1 分钟至 240 分钟之间修改“省电模式超时”。将“省电模式超时”设置为较低
的值可以减少能源消耗，但是可能会增加产品的响应时间。将“省电模式超时”设置为较高的值可以保持较快
的响应速度，但是会使用更多的能源。

关闭模式

此产品有一种关闭模式，仍然会消耗很小量的能源。如要使产品完全不消耗能源，请从电源插座上断开电源
线。

能源消耗总量

有时候计算此产品所消耗的能源总量是非常有用的。因为能源消耗声明是以 Watts（瓦特）作为单位的，因
此，如要计算实际消耗的能源总量，还应该分别乘以此产品在各种模式下所工作的时间。将各种模式下所消耗
的能源加在一起，就是此产品所消耗的能源总量。

无线产品管制通告

本章包含以下有关无线产品（包括但不限于发射机、无线网卡或感应式读卡器）的管制信息。

无线频率辐射暴露通告

此设备的辐射输出能量远远低于美国通信委员会(FCC)和其他管制机构有关无线频率辐射暴露的限制。此设备
的天线和操作人员之间的距离必须保持至少 20 厘米（8 英寸），以满足 FCC 和其他管制机构有关无线频率辐
射暴露的要求。
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